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Preface

Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©September 2010

Trademarks

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive

This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Direc-
tive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark
is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Re orient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator
and your body.

\ A/
2§
Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-

pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

EuP Off Mode Power Consumption Statement:
The figures below note the power consumption of this computer in compliance with European Commission (EC)
regulations on power consumption in off mode:

« Off Mode <1W
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IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1.

Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

Do not use the telephone to report a gas leak in the vicinity of the leak.

Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

This product is intended to be supplied by a Listed Power Unit (Full Range AC/DC Adapter - AC Input 100 -
240V, 50 - 60Hz DC Output 19V, 11.57A (220W) minimum).

This Computer’s Optical Device is a Laser Class 1 Product
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’tdrop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

surface.

Do not place it on an unstable

Do not place anything heavy
on the computer.

2. Keep itdry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

Do not leave it in a place where
foreign matter or moisture may
affect the system.

Don’t use or store the computer
in a humid environment.

Do not place the computer on
any surface that will block the
Vents/Fan Intakes.

Vi




Preface

Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other

strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don'’t forget

to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power until
you properly shut down all pro-
grams.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your computer.

5.

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.

Vi
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Power Safety
The computer has specific power requirements:

ﬁ « Only use a power adapter approved for use with this computer.

\Y
Power Safety  Your AC/DC adapter may be designed for international travel but it still requires a steady,

Warning uninterrupted power supply. If you are unsure of your local power specifications, consult
Before you undertake your service representative or local power company.
any upgrade proce- » The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong
dures, make sure that is an important safety feature; do not defeat its purpose. If you do not have access to a
you have turned off the compatible outlet, have a qualified electrician install one.
power, and discon- » When you want to unplug the power cord, be sure to disconnect it by the plug head, not by
nected all peripherals its wire.
b PR . Make sure the socket and any extension cord(s) you use can support the total current load
telephone lines). It is .

of all the connected devices.

advisable to also re- . e -
move your battery in « Before cleaning the computer, make sure it is disconnected from any external power sup-

order to prevent acci- plies (i.e. AC/DC adapter or car adapter).

dentally turning the

UEELTIE Do not plug in the power Do not use the power cord if | Do not place heavy objects
cord if you are wet. it is broken. on the power cord.

VI
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

» Polymer batteries may experience a slight expansion or swelling, however this is part of the battery’s safety mecha-
nism and is not a cause for concern.

» Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
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Battery Precautions

« Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

» Do not remove any batteries from the computer while it is powered on.

» Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
result in fire.

» If you do not use the battery for an extended period, then remove the battery from the computer for storage.

» Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

« Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

» Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

» Keep the battery away from metal appliances.

» Affix tape to the battery contacts before disposing of the battery.

» Do not touch the battery contacts with your hands or metal objects.

\ A/
2R
Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,

under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 If the computer does not work normally when you follow the operating instructions.

 If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
 If there is an unusual odor, heat or smoke coming from your computer.

SN
L&

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-
ware and software. Make sure your “papers” are handy.

\ A/
ALK
Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer

agprwbPE

N o

from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.

Xl



Preface

On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep itdry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.

X1l
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Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

*Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level
of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

*Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a
footrest if necessary.

*Use a chair with a back and adjust it to support your lower back comfortably.

«Sit straight so that your knees, hips and elbows form approximately 90-degree angles when
you are working.

*Take periodic breaks if you are using the computer for long periods of time.

Remember to:

«Alter your posture frequently.

«Stretch and exercise your body several times a day.

*Take periodic breaks when you work at the computer for long periods of time. Frequent and
short breaks are better than fewer and longer breaks.

XV
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Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.

Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system is not in use.

Cable TV Safety
If you have included a TV Tuner in your purchase option then pay careful attention to the following:

Make sure that your CATV system installer has connected the Coaxial cable shield to the grounding system of the
building, as close to the point of cable entry as practical.

This reminder is provided to call the CATV system installer’s attention to Article 820-93 of the NEC (Section 54, Part
I of the Canadian Electrical Code).

The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner
module outdoors.

XV
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

» Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk,
optical device, 7-in-1 card reader), Game Keys, HDMI Ports, TouchPad & Mouse, Audio Fea-
tures & Printer.

e Chapter 3  The computer’s power management options.

e Chapter 4  The installation of the drivers and utilities essential to the operation or improvement of some of the
computer’s subsystems.

e Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

» Chapter 6 Instructions for upgrading your computer.

e Chapter 7 A quick guide to the computer’s RAID, Bluetooth, Wireless LAN, PC Camera, TV Tuner and
Fingerprint modules (some of which may be optional depending on your purchase configuration).

* Chapter 8 A troubleshooting guide.

» Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external
devices.

» Appendix B Information on the NVIDIA Video driver controls.

» Appendix C Information on the ATI Video driver controls.

» Appendix D The computer’s specification.

Overview 1 -1
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “Drivers & Utilities” on page 4 - 1, “BI0OS Utilities” on page 5 - 1 and “Upgrading The Computer”
on page 6 - 1 in the User’s Manual. You may also find the notes marked with a /# of interest to you.

Beginners and Not-So-Advanced Users

4 If you are new to computers (or do not have an advanced knowledge of them) then
Notes the information contained in this Quick Start Guide should be enough to get you up
: and running. Eventually you should try to look through all the documentation (more

Check the light colored detailed d .. fthe f . d | din th
boxes with the mark etailed descriptions of the functions, setup and system controls are covered in the
above to find detailed remainder of the User’s Manual), but do not worry if you do not understand every-
information about the | thing the first time. Keep this manual nearby and refer to it to learn as you go. You
computer’s features. may find it useful to refer to the notes marked with a ~as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface

(Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows 7) and applications (e.g. word processing, spreadsheet and database programs)
have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component
e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4
- 3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your
system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers
& Utilities” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to com-
municate with external devices, connect to the internet etc.

Overview 1 -3



Quick Start Guide

\ A/
ZAS
TV Tuner Module
Support

Note that the TV Tuner
module (factory) option
is supported by the Win-

dows Media Center
software. Windows Me-
dia Center is not includ-
ed in Starter or Home
Basic versions of Win-
dows 7.

System Software

Your computer may already come with system software pre-installed. Where this is
not the case, or where you are re-configuring your computer for a different system,
you will find the Windows 7 operating system is supported.

Note: In order to run Windows 7 without limitations or decreased performance, your
computer requires a minimum 1GB of system memory (RAM).

RAID & AHCI Setup

Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the
Windows OS (see “Setting Up SATA RAID Mode” on page 7 - 2).

1 -4 Overview



System Startup

1.
2.
3.

Quick Start Guide
Remove all packing materials, and place the computer on a stable surface.

Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter.

Use one hand to raise the lid/LCD to a comfortable viewing angle (it is preferable not to exceed 130 degrees); use
the other hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the
computer by the lid/LCD).

Raise the lid/LCD to a comfortable viewing angle, and press the power button.

4

Shutdown

Note that you should always shut your computer down by choosing the Shut Down command from the Start menu in
Windows 7. This will help prevent hard disk or system problems.

Figure 1 - 1 - Computer with AC/DC Adapter Plugged-In/Opening the Lid/LCD

System Startup 1 -5
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Figure1-2
LCD Panel Open
& Top View

1. Optional Built-In PC

Camera

LCD

LED Status Indicators

4. Touch Sensor

Instant Keys

8 * Gaming Keys

Keyboard

7. TouchPad and
Buttons

8. Fingerprint Reader
Module (optional)

9. LED Power Indicators

10. LCD Panel Color
LED

w N

oo

See Appendix A for a more
detailed description of the
ports & jacks etc.

1 -6 System Map: LCD Panel Open & Top View

System Map: LCD Panel Open & Top View

\ A/
2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable elec-
tronic transmission devices (e.g.
WLAN or Bluetooth) aboard air-
craft is usually prohibited. Make

sure any wireless modules are
OFF if you are using the comput-
er aboard aircraft.

Use the appropriate function key
combination/Touch Sensor Key
to toggle power to any wireless
modules, and check the indica-
tors to see if any modules are
powered on or not (see

).




LED Indicators
The two sets of LED indicators (LED Status Indica-
tors and LED Power Indicators) display helpful in-
formation about the current status of the computer.

Icon Color Description
Blinking Blue Hard Disk Activity
Blue Number Lock is Activated
Blue Caps Lock is Activated
Blue Scroll Lock is Activated
Green The Computer is On
Blinking The Computer is In Sleep Mode
Green
Orange The Battery is Charging
Blinking The Battery has Reached
Orange Critically Low Power Status
Green The Battery is Fully Charged

Table 1 -1 - LED Status Indicators

Quick Start Guide
Game Keys

The eight Game Keys on the left of the computer al-
low macros to be configured for common keystrokes
used in applications, as long as the driver is installed.

Figure 1 - 3 - Game Key Configuration

.|
System Map: LCD Panel Open & Top View 1 -7
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Touch Sensor Instant Keys

Press the Touch Sensor Instant Keys on the computer to toggle the appropriate function on/off. When a module
is powered on the appropriate icon will be highlighted.

Icon Description Icon Description
LED Color Toggle (press to toggle Wireless LAN Module Power Toggle
flashing colors or single color) Make sure that Wireless is ON in the Windows Mobility Center to

ensure proper wireless instant key behavior (see page 3 - 11).

PC Camera Module Power Toggle Activate the Default Internet Browser

Bluetooth Module Power Toggle Sound Effects Equalizer Mode Toggle
(see page 2 - 21)

Toggle *Silent Mode (for power saving)
Visual Indicator

Mute Toggle

Volume Control Slider (move your finger slowly along the slider to
adjust the system volume)

Table 1 - 2 - Touch Sensor Instant Keys

*When enabled, Silent Mode will reduce fan noise and save power consumption. Note this may reduce comput-
er performance.

1 -8 Touch Sensor Instant Keys



Keyboard

The keyboard has an embedded numerical keypad for easy numeric data input, and
features function keys to allow you to change operational features instantly. See
Table 1 - 3, on page 1 - 10 for full function key combination details.

Function Keys

Play/Pause Key

[ ]

NumLk &
ScrLk Keys

Numerical
Keypad

Quick Start Guide

4

Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial  functions/hot-keys
unique to the system’s
regular keyboard may not
work.

Num Lk & Scr Lk

Fn Key Hold down the Fn Key

Figure 1 - 4 - Kevboard and Scr Lk/Num Lk to en-

9 y able scroll lock/number

lock, and check the LED
/ indicator for status.

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.

These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

Keyboard 1-9
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Function Keys & Visual Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition to the
basic function key combinations; visual indicators (see the table below) are available when the Hot Key driver is in-
stalled (see “Hot Key” on page 4 - 6). After installing the driver an icon & will appear in the taskbar.

Keys Function/Visual Indicators Keys Function/Visual Indicators
Fn + ~ Play/Pause (in Audio/Video Programs) Fn +F8/F9 Brightness
Decrease/Increase
Fn+F1 Touchpad Toggle Fn + F10 PC Camera Power
Toggle
Turn LCD Backlight Off *WLAN Module
Fn+F2 (Press a key to or use Touchpad to turn on) Fn+Fll Power Toggle
Fn + F3 Mute Toggle Fn + F12 Bluetooth Module
Power Toggle
Fn+F4 Sleep Toggle Fn + NumLk Number Lock Toggle
Fn +F5/F6 Volume Decrease/ Fn + ScrLk Scroll Lock Toggle
Increase
Display Toggle ) ) ] ] -
Fn + F7 Note: DO NOT use the Fn + F7 key combination to toggle | Make sure that Wireless is ON in the Windows Mobility Center to
ensure proper wireless function key behavior (see page 3 - 11).

through display options when SLI is enabled (see “ SLI Multi
GPU Configuration” on page B - 14).

Table 1 - 3 - Function Keys & Visual Indicators

1-10Keyboard
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System Map: Front & Rear Views Figure 1 - 5

Front View

1. Color LEDs

Speakers

3. LED Power
Indicators

4, Consumer Infrared
Transceiver
(enabled with
optional TV Tuner

only)
5. DC-In Jack

N

SN
ALK

See Appendix A for a more
detailed description of the
Note that the TV Tuner module (factory) option is supported by the Windows Media Cen- ports & jacks etc.

ter software. Windows Media Center is not included in Starter or Home Basic versions

of Windows 7.

TV Tuner Module Support

System Map: Front & Rear Views 1 - 11
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Figure 1- 6 System Map: Right View

Right View

1. Headphone-In Jack
2. Microphone-In Jack @ @
3. Line-In Jack
4. SIPDIF-Out Jack 0060¢g [7) 0
5. Cable (CATV)

Antenna Jack®
6. Combined eSATA/ ;Il’;

USB Port
7. USB 2.0 Port TV Tuner Module Support
8. Security Lock Slot Note that the TV Tuner module (factory) option is supported by the Windows Media Cen-
9. Power Button ter software. Windows Media Center is not included in Starter or Home Basic versions

of Windows 7.

*Enabled with  Optional USB Ports

Mini-PCI TV Tuner Only

Note that the connections to the USB ports only fit one way, do not force them.

See Appendix A for a more
detailed description of the
ports & jacks etc.

.|
1-12 System Map: Right View
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System Map: Left View Figure 1- 7

Left View

DVI-Out Port
2*USB 2.0 Ports
RJ-45 LAN Jack
HDMI-Out Port
7-in-1 Card Reader
2*USB 3.0 Ports
HDMI-In Port
Mini-IEEE 1394 Port

Mini-IEEE 1394 Port Optical Device Drive
The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices. Bay

O o 60 99_@_0@1

4

©CoNoGO~WNE

7-in-1 Card Reader See Appendix A for a more
The card reader allows you to use the most popular digital storage card formats: detailed description of the

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) ports & jacks etc.
MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter)
Mini SD (requires PC adapter) / RS MMC (requires PC adapter) _Q_

2N
HDMI Ports

Note that the HDMI Ports support video and audio signals to attached external displays (also see
“HDMI Ports” on page 2 - 8).

USB Ports

Note that the connec-
USB 3.0 Port OR USB 2.0 Port tions to the USB ports

The USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. The USB 3.0 port only fit one way, do not
requires a driver installation (see “USB 3.0” on page 4 - 6). force them.

System Map: Left View 1 - 13
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Disk Eject Warning

Don't try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don't try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.

4

Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.

.|
1-14 System Map: Left View



System Map: Bottom View

4

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 10 for full instructions.

Quick Start Guide

Figure1-8
Bottom View

=

Sub Woofer

Fan Outlet/Intake

3. Component Bay
Cover

4. Battery
(Secondary HDD
Bay - HDD3)

5. Primary HDD Bay

(HDD1 & 2)

See Appendix A for a more
detailed description of the
ports & jacks etc.

2MN\L
I

Overheating

n

To prevent your comput-
er from overheating make
sure nothing blocks the
vent(s)/fan intake(s)
while the computer is in
use.

System Map: Bottom View 1 - 15
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Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

Click here to toggle Category View

Figure 1 - 9 - Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

.|
1-16 System Map: Bottom View
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Video Features

This computer features two different (either ATI or NVIDIA) video options. You will be provided with an ap-
propriate driver on the Device Drivers & Utilities + User’s Manual Disc. You can switch display devices, and con-
figure display options, from the Display control panel (in Appearances and Personalization) in Windows 7.
For more detailed video information see “NVIDIA Video Driver Controls” on page B - 1 or

“ATI Video Driver Controls” on page C - 1.

To access Display (Control Panel) and Screen Resolution in Windows:

1. Click Start and click Control Panel.

2. Click Display (icon) - In the Appearances and Personalization category.

3. Click Adjust Screen Resolution/Adjust resolution.

OR

4. Alternatively you can right-click the desktop and select Screen resolution (see right).

5. Use the dropbox to select the screen Resolution @ (Figure 1 - 10 on page 1 - 18).

6. Click Advanced settings @ (Figure 1 - 10 on page 1 - 18) to bring up the Advanced properties tabs.

To access the NVIDIA Control Panel (see Appendix B for detailed information):
1. Right-click the desktop and select NVIDIA Control Panel.
1. See “NVIDIA Video Driver Controls” on page B - 1 for full details on control panels etc.

To access the ATI Catalyst Control Center (See Appendix C for detailed information):
1. Right-click the desktop and select Catalyst(TM) Control Center.
2. See “ATl Video Driver Controls” on page C - 1 for full details on control panels etc.

Video Features 1 - 17
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Screen Resolution

e
Video Card Options

Note that card types, specifica-
tions and drivers are subject to
continual updates and changes.
Check with your service center for
the latest details on video cards
supported.

0 Note that not all video card op-
tions for this computer model se-
ries support SLI configuration
(see “Video Adapter Options”

9 on page D - 2, or contact your
service center for details).

Figure 1 - 10 - Screen Resolution

1 - 18 Video Features
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NVIDIA Control Panel

You can also access the NVIDIA Control Panel from the Windows control panel @ or as follows:

1. Click Start and click All Programs > NVIDIA Corporation.
2. Click to select NVIDIA Physx Properties @.

OR
3. Click Advanced settings (Figure 1 - 10 on page 1 - 18) in the Screen Resolution control panel in Windows.

4. Click GeForce....(tab) and click Start the NVIDIA Control Panel Q

o>

Figure 1 - 11 - NVIDIA Control Panel

Video Features 1 - 19
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ATI Catalyst® Control Center
You can also access the ATI Catalyst® Control Center as follows:

1. Click Start and click All Programs (or just click Start and select ATI CCC @).

2. Click Catalyst Control Center.

3. Click ATI CCC (Advanced/Wizard).

OR

4. Double-click the taskbar icon 9 Note that you can add the ATI icon to the taskbar (Enable System
Tray Menu) from the Catalyst Control Center’s Options > Preferences menu Q

P =%

Note: It is recommended that you use only the ATI Catalyst Control
Center to switch and configure attached displays.

Figure 1 - 12 - ATI Catalyst® Control Center

1 - 20 Video Features
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Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 16) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change plan settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 11.

Figure 1 - 13 - Power Options

Power Options 1 -21
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Storage Devices, Mouse, Audio & Printer

Chapter 2. Storage Devices, Mouse, Audio &
Printer

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive

Optical Device

7-in-1 Card Reader

Game Keys

HDMI Ports

Audio Features

TouchPad and Buttons/Mouse
Adding a Printer

. |
Overview 2 - 1
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Hard Disk Drive

\ A/

’Zl‘ The hard disk drive(s) is(are) used to store your data in the computer. The hard
Power Safety disk(s) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives

SO e - with aheight of 9.5 mm. The primary hard disk bay @ is accessible from the bottom

ceesee R ETE el of your computer as seen below, and the secondary hard disk bay @ is located under

celecER eI CEIE  the battery compartment.

computer please ensure

UEEGERNECIERERIG Sl The computer can accommodate up to three hard disks (two in the primary bay, and
S e Sl one in the secondary bay), and these may be configured in RAID or AHCI modes.

power, and that the ma- . . . . . . - .
SR el Further details on removing and inserting the hard disk are available in “Upgrading

ensure that all peripher- the Hard DISk DrIVG(S)" on page 6 - 4
al cables, including

phone lines, are discon-

nected from the comput-

er.

Figure2-1
Hard Disk Location

2 - 2 Hard Disk Drive
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Optical Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the model you purchased (see “Storage” on page D - 3). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Boot Menu” on page 5 - 12).

Loading Discs

To insert a CD/DVD, press the open button @ and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator @ will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole
© to open the tray.

4

Sound Volume
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting.

Peripherals must be
connected before you
turn on the system.

Figure 2 - 2

Optical Device

Optical Device 2 - 3
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Handling CDs or DVDs

\ A/

2§ Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be

CD Emergency Eject
accessed.

If you need to manually

SRR e RETERCRE  Note the following:
an unexpected power

LICET B CER g EVAR  «  Hold the CD or DVD by the edges; do not touch the surface of the disc.
SSERENERCIERRERE o Use a clean, soft, dry cloth to remove dust or fingerprints.
fg[g'&fiﬁggﬁfejce“g « Do not write on the surface with a pen.

e SEEE el ¢ Do not attach paper or other materials to the surface of the disc.
SeNeRE TEEEERETEl o Do not store or place the CD or DVD in high-temperature areas.

SUEeR I ERE S IEIEE o Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
SOLERES I EEECSE .« Do not bend the CD or DVD.

db lodged i -
;ne hoﬁfome =8 . Do not drop or subject the CD or DVD to shock.

Disk Eject Warning

Don't try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.

.|
2 - 4 Optical Device
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DVD Regional Codes 5
To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 14.
DVD Regional Coding
Region Geographical Location Table2-1
DVD Regional Coding
1 USA, Canada
5 Western Europe, Japan, South
Africa, Middle East & Egypt
South-East Asia, Taiwan, South
3 Korea, The Philippines, Indonesia,
Hong Kong
4 South & Central America, Mexico,
Australia, New Zealand
5 N Korea, Russia, Eastern Europe,
India & Most of Africa
6 China

Optical Device 2 - 5
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4

Card Reader Cover

Make sure you keep the
cover in the card reader
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the card read-
er.

Figure 2 -3
Right View

1. Card Reader

7-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “Card Reader” on page 4 - 6).

* MMC (MultiMedia Card) * MS Duo (requires PC adapter*)
» SD (Secure Digital) * Mini SD (requires PC adapter*)
e MS (Memory Stick) * RS MMC (requires PC adapter*)

e MS (Memory Stick Pro)

*Note: The PC adapters are usually supplied with these cards.

2 - 6 7-in-1 Card Reader
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Game Keys

The eight game hot keys on the left of the computer allow macros to be configured
for common keystrokes used in applications (the keys can assigned macros for any
program, not only games). To configure the keys follow the instructions below
(make sure you have installed the GameKey Utility driver - see “GameKey Utility”

on page 4 - 6).
1. Runthe Game Key Configuration program from the desktop icon (or from
C:\Program Files\Chicony\GameKeys\GmKeyCfgUtl.exe).
2. Double-click the button  for the appropriate key (it will turnred ).
3. When the buttonisred  you may then record the keystrokes to be assigned to
the Game Key.
Figure2 -4
Game Key
Configuration
4. Click OK.
5. Repeat the procedure for the other Game Key if required.
6. Close the Game Key Configuration window.
7. The keystroke order will be repeated with the appropriate button press in any

application program.

Game Keys 2 - 7
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HDMI Ports

This computer features both HDMI (High-Definition Multimedia Interface) input
and output ports. HDMI is a compact audio/video interface for transmitting uncom-
pressed digital data.

* The HDMI-Out port allows you to display and hear video/audio sources from
your computer to digital TVs, displays or audio systems that support an HDMI
input.

* The HDMI-In port allows you to display external sources such as Blu-ray play-
ers, DVDs, set top boxes and games consoles etc. on your computer screen.

See “NVIDIA Video Driver Controls” from page B - 1/“ATI Video Driver Con-
trols” from page C - 1 for information on setting up external displays connected to
the HDMI-Out port.

Make sure you install the HDMI-In driver in order to support any HDMI input sourc-
es (see “HDMI-In Driver” on page 4 - 7). When the HDMI-In driver is installed the
GameMate Media Player will be installed.

2 - 8 HDMI Ports
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GameMate Media Player (HDMI-In)

The GameMate Media Player allows you to play content from digital sources
through the HDMI-In port.

1.
2.

3.

Connect your digital source to the HDMI-In port using an HDMI cable.
Access the GameMate Media Player from the desktop shortcut or from
GameMate folder in Program Files.

Press play on any attached digital source player (or use a remote control to
navigate the menus of consoles etc.).

The picture will appear in the GameMate Media Player.

Figure2-5
GameMate Player

HDMI Ports 2 - 9
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You can also right-click the screen to access the configuration menu to adjust any of

Double-click the GameMate screen to toggle through different screen size options.
the following settings:

RENDERED QUALITY
Select High, Medium or Low quality from this menu item.

RENDERED QUALITY » | v HIGH
STANDARD MEDIUM
LOW
STANDARD
Select NTSC or PAL standard from this item.
STANDARD P ¥ NTSC
FORMAT b PAL
FORMAT
Select the screen format here (only supported resolutions will be shown).
STANDARD » [ ¥ NTSC
FORMAT b PAL

|
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ASPECT

The Aspect item allows you to select standard or wide screen aspect ratios.
ASPECT > 4:3
SMAPSHOT (BMP ) ¥ ]| 16:9

SNAPSHOT
Click either the BMP or JPG items to take a screen shot of the current GameMate
screen (the file will be placed in the Pictures library folder in Windows).

SMAPSHOT (EMP )

SMAPSHOT (JIPG)

TOPSHOT
If enabled then the GameMate screen will remain on top of other windows.

¥ TOPMOST

HDMI Ports 2 - 11
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Figure 2 - 6
Sound Playback
Options

2 - 12 HDMI Ports

HDMI Audio Configuration
As HDMI (High-Definition Multimedia Interface) carries both audio and video sig-
nals you can configure the audio output as per the instructions below.

Audio Setup for HDMI

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound  (Hardware and Sound).

Click Playback (tab), and click to select Realtek Digital Output.

Click Set Default (button).

Click OK to close the Sound  control panel.

Select Speakers as the default for standard audio sources.

ok wppE

>
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Audio Setup for LCD Monitors/TVs with HDMI Input

Some LCD monitors/TVs support HDMI input, but DO NOT have built-in digital
audio decoders. Where this is the case, when playing DVDs in Windows Media
Player/CyberLink Power DVD, a background noise can occur. If this situation does
arise then please follow the instructions below.

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound  (Hardware and Sound).

Double-click Realtek Digital Output.

Click Supported Formats (tab).

Click to disable (remove the check in the box) DTS Audio and Dolby Digital.
Click OK and close the control panels.

ok wnE

O

Figure 2 -7
Sound
Supported Formats
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HDMI Notes
2 4 » Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-

it Apr e ing to play audio/video sources through the device.

If you are using a third | * Ifyou disconnect the HDMI cable the default audio playback device will not

party application to play revert to speakers until the computer is restarted (if you do not wish to restart the
DVDs etc. you will need computer then go to the Sound control panel and select Speakers as the default
to consult the applica- audio playback device).

tion’s documentation to
see the appropriate au- | HDM]I Video Configuration
oL .Conf'gurat'on (s 1. Connect an HDMI cable from the HDMI-Out port to your external display.
appllcatlon must support 2. Configure your external display as per the instructions in “Configuring an
digital to analog transla- : ’ i
tion). External Display using the NVIDIA Control Panel” on page B - 7.

3. Set up your external display (TV or LCD) for HDMI input (see your display device

manual).
4. You can now play video/audio sources through your external display.

|
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Audio Features

You can configure the audio options on your computer from the Sound  control

4

panel in Windows, or from the Realtek HD Audio Manager gj icon in the taskbar/ SO Vo Ui
Adjustment

control panel (right-click the taskbar icon g to bring up an audio menu). The volume
may also be adjusted by means of the Fn + F5/F6 key combination or by moving | The sound volume level
your finger slowly along the Touch Sensor volume control slider (see Table 1 - 2, | S set using the volume
on page 1 - 8) control within Windows
pag ' (and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to

check the setting.

Right-click the icon§i
to access the menu

above.
Figure 2 - 8
See “HDMI Audio Configuration” on page 2 - 12 for a description of the audio Realtek Audio
configuration when connecting an HDMI supported display device. Manager

Audio Features 2 - 15
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Suppressing Audio Background Noise

A background noise may occur when audio power management is enabled, and the
system resumes from power saving. To solve this problem you can disable Realtek
HD Audio Manager Power Management.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel)
and make sure you are in Classic View.

2. Click Realtek HD Audio Manager (or right-click the taskbar icon ﬂ and select
Sound Manager).

3. Click the Power Management icon [m].

Figure2-9
Realtek Audio
Manager
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4. Make sure that Power Management is disabled (when disabled the icon will be
black .; when enabled the icon will be blue ).
5. Click OK to save the setting and close the control panel.

\ The black icon . ndicates that

Power Management is disabled.

Figure 2 - 10
Realtek Audio
Manager
Power Management
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4

Beam Forming

If your stereo micro-
phone supports Beam
Forming (Directional
Recording), then click
the button to calibrate
the stereo microphone
before recording.

Figure2-11
Realtek Audio
Manager -
Recording Setup

Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instruc-

tions below:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel)
and make sure you are in Classic View.

2. Click Realtek HD Audio Manager (or right-click the taskbar icon ﬁ and select
Sound Manager).

3. Click Microphone Effects (tab) in Microphone (tab), and then click to select
Noise Suppression (button), or adjust the Recording Volume level to around 60,
to obtain the optimum recording quality.

4. Click OK to close the control panel and save the settings.

-

O
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Setup for 5.1 Surround Sound

To setup your system for 5.1 surround sound you will need to connect the audio ca-
bles to the Line-In and Microphone-In jacks.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel)
and make sure you are in Classic View.

2. Click Realtek HD Audio Manager (or right-click the taskbar icon ﬁ and select
Sound Manager).

3. Click Speakers (tab) and click Speaker Configuration (tab).

4. Select 5.1 Speaker from the Speaker Configuration pull-down menu.

4

Connector Settings
\.‘CD Auto Popup Dialog

You should enable the Figure 2 - 12
auto popup dialog to au- Speaker
tomgtlcally detect when a Configuration
device has been
plugged-in. If disabled,
double-click connector
settings and click the
box to enable the auto
popup detection of
plugged-n devices.
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o

Figure 2 - 13
Connected Device
Auto Popup

Plug the front speaker cables into the Headphone-Out Jack.

Plug in the other cables (you may require an adapter to connect each cable to the
appropriate jack e.g a stereo mini to dual RCA adapter) from your speakers as
follows:

Line-In Jack = Rear Speaker Out
Microphone-In Jack = Center/Subwoofer Speaker Out

As you plug in each cable a dialog box will pop up (see “Auto Popup Dialog” on
page 2 - 19).

Click to put a tick in the appropriate box according to the speaker plugged-in (e.g.
Rear Speaker Out), and then click OK to save the setting.

Click OK to exit Realtek HD Audio Manager.
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Sound Effects Equalizer

Press the Sound Effects Equalizer Mode Toggle button to toggle through
some of the equalizer options (an on-screen icon will appear to show the selected
mode). A more comprehensive list of options is available from the Equalizer drop-

down list.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel)
and make sure you are in Classic View.

2. Click Realtek HD Audio Manager (or right-click the taskbar icon ﬁ and select
Sound Manager).

3. Click Digital Output (tab), click Sound Effects (tab) and then click to select an
option in the Equalizer drop-box.

4. Click OK to close the control panel and save the settings.

, Audio & Printer

Figure 2 - 14
Realtek Audio
Manager -
Recording Setup
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5 Dolby Settings
You can adjust the Dolby settings from the Dolby tab in Speakers Properties.

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound (Hardware and Sound).

Click Playback (tab).

Double-click Speakers (or select Properties from the right-click menu).

Click Dolby (tab)

Adjust the settings to your preferences and click OK.

ok wpdpE

Figure 2 - 15
Speakers Properties
Dolby Settings

. |
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TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse.

Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 6) you
can configure the functions from the Mouse control panel in Windows, or by double-
clicking the TouchPad driver icon  on the taskbar. You may then configure the
TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your
preferences. You will find further information at www.synaptics.com.

TouchPad and Buttons/Mouse 2 - 23

4

TouchPad Scrolling

This computer model se-
ries may feature different
TouchPad versions.

These TouchPads may
differ in their vertical
scrolling function in most
scrollable windows.

Some TouchPads require
sliding the finger up and
down on the right of the
TouchPad to scroll the
window. Other versions
require  tapping/holding
down the finger at the top
right or bottom right of the
TouchPad to scroll the
window.

Figure 2 - 16
Mouse Properties
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4

Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture (Pinch
Zoom, Rotating, Three
Fingers Down and
Three Finger Flick) in the
Device Settings > Set-
tings left tree menu

and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

Figure 2 - 17
Mouse Properties -
Device Settings

Gestures and Device Settings

The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
tion) on the surface of the TouchPad to perform specific actions to manipulate doc-
uments, objects and applications.

You can configure the settings from the Device Settings tab in Mouse Properties:

Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mouse (Hardware and Sound).

3. Click Device Settings (tab) and click Settings.

4. Use the menu tree on the left to access the user configurable settings.

-
O

=
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Scrolling

The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the
TouchPad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

Zooming

The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the TouchPad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.

Figure 2 - 18

Scrolling Gesture

4

Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’'s user docu-
mentation for details.

Figure 2 - 19
Zooming Gesture
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Rotating

Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another
finger near the middle of the TouchPad and slide it in a circular motion around the
stationary finger (clockwise or counterclockwise) to rotate the object.

Figure 2 - 20
Rotating Gesture

Three Finger-Flick/Three Fingers Down (Press)

The Three Finger-Flick gesture may be used to enhance navigation with a variety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-selectable applications.

Figure 2 - 21
Flick/Press
Gesture

. |
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Adding a Printer

The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer

Most new printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:

1.

aprwn

Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-
tridge etc.).

Turn ON the computer.

Turn ON the printer.

Connect the printer's USB cable to one of the USB ports on the computer.
Windows will identify the printer and either load one of its own drivers or ask you
to supply one. Follow the on-screen instructions.

Parallel Printer

This is still a very common type of printer. The install instructions are in the sidebar
(you will need to purchase a parallel to USB converter).

Adding a Printer 2 - 27

4

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer's
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
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Power Management

Chapter 3. Power Management P

Overview OS Note

To conserve power, especially when using the battery, your computer power man- | Power  management

L functions will vary slight-
agement conserves power by controlling individual components of the computer ly depending on_ your

(the LCD and hard disk drive) or the whole system. operating system. For
. more information it is
This chapter covers: best to refer to the user's
» The Power Sources manual of your operat
« Turning On the Computer 9 system:
« Power Plans (Note: All pictures used
* Power-Saving States on the following pages
» Configuring the Power Buttons grg_;rom the Windows 7

» Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

. |
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

3
. AC/DC Adapter

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components (see page D - 4).

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer.

2. Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do | completely discharge the battery?”
on page 3 - 14).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 10.

. |
3 - 2 The Power Sources



Power Management

Turning On the Computer P

Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel. Forced Off

: : If the system “hangs”,
When the computer is on, you can use the power button as a Stand by/Hibernate/ i s G 2 T ]

Shthown hot-key button when it is pressed _for I_ess than 4 seconds (pressing and | ey combination doesn't
holding the power button for longer than this will shut the computer down). Use | work, press the power
Power Options in the Windows control panel to configure this feature. button for 4 seconds, or

longer, to force the sys-
tem to turn itself off.

4
Power Button as
Shut Down Stand by or

Note that you should always shut your computer down by choosing the Shut Down com- Hibernate Button

mand from the bottom right of the Start menu in Windows. This will help prevent hard disk You can use the OS’s

or system problems. Power Options control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page 3
- 8 for details).

.|
Turning On the Computer 3 - 3
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4

Resuming
Operation

See Table3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure3-1
Power Plan
Advanced Settings
(Win 7)

Power Plans

The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

3 - 4 Power Plans



Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Click to Show/Hide
additional
power plans

Power Management

Figure 3-2
Power Plans (Win 7)
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Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where
you left off. Win 7 uses the Sleep, Hibernate and Shut Down power-saving states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

3 - 6 Power-Saving States



Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down

You should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

Win 7

-

Power-Saving States 3 - 7
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4

Silent Mode

You can use Silent
Mode to reduce power
consumption and fan
noise. Use the Silent
Mode Touch Sensor In-
stant Key to toggle
this mode on/off.

On screen visual indica-
tors and the
Touch Sensor Instant
Key will display the
Silent Mode status (see
Table 1 -2, on page 1 -
8).

Note Silent Mode may
reduce computer perfor-
mance.

Figure 3-3
Start Menu Power



Power Management

Configuring the Power Buttons

Z The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
Password computer in to a power-saving state. Click Choose what the power buttons do on
Protection the left menu in Power Options to bring up the menu.

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3-4
Power Options
Define Power
Buttons

.|
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Resuming Operation

You can resume operation from power-saving states by pressing the power button, Z
or in some cases pressing the sleep button (Fn + F4 key combo). Closing the Lid
If you have chosen to
Power Status Icon Color To Resume send the computer to
Sleep when the lid is
Power Off Off Press the Power Button closed, raising the lid

will wake the system up.

Press the Power Button

Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery) Table3-1
Hibernate Press the Power Button Resuming
Orange (AC/DC adapter) .
Operation

Display Turned Off Green Press a Key or Move the Mouse/Touchpad

4

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down

hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

Configuring the Power Buttons 3 - 9
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Battery Information

\ A/
’ﬁl\ Follow these simple guidelines to get the best use out of your battery.
Low Battery

Warning Battery Power

Whenihe bareryis oriti Your computer’s ba_ttery power _is dependeqt upon many factors, includin_g the pro-
VA e ie o @ grams you are running, and peripheral devices attached. You can set actions to be
o s R e el taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
SCEUERCREREIEIE A power plan Change plan settings > Change advanced power settings (see Figure

or save your work, oth- ) _
erwise, the unsaved 3-1lonpage3 4)'

data will be lost when
the power is depleted.

Click the battery icon [d in the taskbar to see the current battery level and charge
status.

Figure 3-5
Battery Icon
(Taskbar) & Battery
Advanced Settings

.|
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Conserving Battery Power

» Use a power plan that conserves power (e.g Power saver), however note that ﬂ:
this may have an affect on computer performance. Wireless Hot Keys

* Lower the brightness level of the LCD display. The system will decrease LCD The computer's wireless
brightness slightly to save power when it is not powered by the AC/DC adapter. function keys will not func-

. ) . i ly if Wireless i
+ Reduce the amount of time before the display is turned off. ured OFE i the Win

* Close wireless, Bluetooth, modem or communication applications when they are BRSNS IEELIARC S

. control panel.
not being used.

« Disconnect/remove any unnecessary external devices e.g. USB devices, S UIEISS HINGICalor

I nay show that
ExpressCards etc. the WLAN module is pow-

ered on, however if wire-
less is OFF in the Mobility
Center, the module will not
be powered on.

4

Windows Mobility
Center

Make sure that Wireless is

ON in the Mobility Center to

ensure proper function key

behavior.

The Windows Mobili-
ty Center control pan-

el provides an easy
point of access for in-
formation on battery .
status, power plans Figure 3-6
used and wireless de- Windows Mobility
vice status etc. Center

Make sure Wireless is ON to ensure proper function key behavior.

Battery Information 3 - 11
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Battery Life

Battery life may be shortened through improper maintenance. To optimize the life

and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see “Removing the Battery”
on page 6 - 3.

New Battery

Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 7 for information on the battery charge status, and to “Battery In-
formation” on page 3 - 10 for more information on how to maintain and properly
recharge the battery pack.)

.|
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Proper handling of the Battery Pack

» DO NOT disassemble the battery pack under any circumstances. ?ﬁl’:
» DO NOT expose the battery to fire or high temperatures, it may explode. Callion
* DO NOT connect the metal terminals (+, -) to each other.

AN
Ik

Damaged Battery Warning

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer

down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do I completely discharge the battery?

Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let

the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure 3-7
Power Plan Create
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3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

Figure 3-8
Change Plan
Settings / Change
Advanced Power
Settings

.|
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

Figure 3-9
Power Options
Advanced Settings -
Battery

* Low battery levels = 0%

 Critical battery Levels = 0%

* Low battery action = Do Nothing

 Critical battery action (On battery) = Shut Down
* Critical battery action (Plugged in) = Do Nothing

.|
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.

How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

SLI Multi GPU Configuration & Battery Power

Note that due to the high power and system demands created by enabling SLI Configura-
tion, you should not enable SLI configuration if your computer is powered by battery
only. If you attempt to run an SLI configuration when the computer is powered by the bat-
tery only, then system problems may occur.

If the computer is currently powered by battery only do not enable SLI configuration.

If you have currently enabled SLI configuration, and the computer is powered by the AC/
DC adapter, do not switch to battery power only (or go to the NVIDIA Control Panel and
disable SLI configuration before switching to battery power only).

.|
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Drivers & Utilities

Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities.

RAID & AHCI Setup

Note that setting up a RAID, or AHCI mode, needs to
be done prior to installing the Windows OS, and there-
fore before installing the other drivers listed here (see
“Setting Up SATA RAID or AHCI Modes” on page 7
- 36).

What to Install

The Device Drivers & Utilities + User’s Manual disc
contains the drivers and utilities necessary for the
proper operation of the computer.

Table 4 - 1, on page 4 - 3 lists what you need to install
and it is very important that the drivers are in-
stalled in the order indicated.

Module Driver Installation

The procedures for installing drivers for the WLAN,
PC Camera, Consumer Infrared (for TV tuner re-
mote), Fingerprint and Bluetooth Combo modules
are provided in “Modules” on page 7 - 1.

What to Install 4 - 1
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Driver Installation

Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button), or Option Driv-
ers (button) to access the Optional driver menu.

Figure 4 - 1 - Drivers Installer Screen 1

Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in
this order) which is the same as that listed in the
Drivers Installer menu below.

Click to select the driver you wish to install, (you
should note down the drivers as you install them).
Follow the instructions for each individual driver
installation procedure as listed on the following
pages.

Figure 4 - 2 - Drivers Installer Screen 2

4 - 2 Driver Installation



Windows 7 Driver Page
Video - NVIDIA (NVIDIA or ATI) Page 4 -5
Audio Page 4 -5
LAN Page 4 -6
TouchPad Page 4 - 6
Card Reader Page 4 -6
GameKey Utility Page 4 -6
USB 3.0 Page 4 - 6
Hot Key Page 4 - 6
HDMI-In Driver Page 4 -7
Intel® Matrix Driver Installation (for RAID) Page7-7
Wireless LAN Module Page 7 - 12
PC Camera Module Page 7 - 18
TV Tuner Module Page 7 - 26
Fingerprint Reader Module Page 7 - 29
Bluetooth Module (Driver for Combo Module Only) Page 7 - 36

Table 4 - 1 - Driver Installation

Drivers & Utilities

Manual Driver Installation

Click the Browse CD/DVD button in the Drivers In-
staller application and browse to the executable file in
the appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
7 for instructions.

Driver Installation 4 - 3
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Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)

If a User Account Control prompt appears as part of
the driver installation procedure, click Continue/Al-
low, and follow the installation procedure as directed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue the in-
stallation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found

If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

4 - 4 Driver Installation



Driver Installation Procedure

Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button), or Option Driv-
ers (button) to access the Optional driver menu.

4

Driver Installation General Guidelines

The driver installation procedure outlined in this
Chapter (and in Chapter 7 Options & Modules),
are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.

RAID Note: Setting up a RAID, or AHCI mode,
needs to be done prior to installing the Windows OS,
and therefore before installing the other drivers listed
here.

Drivers & Utilities

Video - NVIDIA

1. Click 1.Install Video Driver > Yes.
2. Click Next > Yes > Next.
3. Click Finish to restart the computer.

Video - ATI

1. Click 1.Install Video Driver > Yes.

2. Click Next > Install (button).

3. Click the Express (or Custom if you prefer to
manually configure the driver installation set-
tings) button and click Next.

4. Click Accept (button) and click Yes.

5. Click Finish > Yes to restart the computer.

Audio

1. Click 2. Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Driver Installation 4 - 5
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LAN

Make sure you have plugged the network cable in be-
fore installing the driver.

1. Click 3.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish to complete the installation.

TouchPad

1. Click 4.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license, and then
click Next.

4. Click Finish > Restart Now to restart the com-
puter.

Card Reader

1. Click 5.Install Cardreader Driver > Yes.
2. Click Install > Finish.

GameKey Utility

1. Click 6.Install GAMEKkey Driver > Yes.

2. Click Next.

3. Click Finish to restart the computer.

4. See “Game Keys” on page 2 - 9 for information.

USB 3.0

1. Click 7.Install USB 3.0 Driver > Yes.

2. Click Next.

3. Click the button to accept the license and then
click Next.

4. Click Next > Install.

Click Finish.

Hot Key

1. Click 8.Install Hotkey Driver > Yes.

2. Click Next > Next.

3. Click Finish > Finish to restart your computer.

You should install the HDMI-In driver if you intend to
play and audio/video sources through the computer’s
HDMI-In port (see over).

4 - 6 Driver Installation



HDMI-In Driver

1. Click Back (button) and then click Option
Drivers (button).

2. Click 6.Install HDMI In Driver > Yes.

3. Click Next.

4. Click Finish (the application will prepare to
install).

5. Click Next > Install.

6. Click Finish.,

7. The GameMate application will appear on the

|
Driver Installation 4 - 7

desktop.
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4

Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Click Check for updates (Security), or double-
click Security Center and click Windows Update.

3. Double-click Check for updates (button).

4. The computer will now check for updates (you
need to be connected to the internet).

5. Click Install now (button) to install the updates.
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Optional Drivers

See the pages indicated for the driver installation pro-
cedures for any modules included in your purchase op-
tion.

Figure 4 - 3 - Optional Drivers Installer Screen

RAID Setup

Note: Prior to setting up the RAID you will need to use
an operable computer to copy the RAID driver to a
USB flash drive before installing the Windows Vista
operating system. See “Setting Up SATA RAID
Mode” on page 7 - 2 for configuration instructions.

Wireless LAN

See the appropriate install procedure for your WLAN
module in “Wireless LAN Module” on page 7 - 11.

PC Camera

See the install procedure in “PC Camera Module” on
page 7 - 17.

Consumer Infrared (for TV Tuner Remote)

See the install procedure in “TV Tuner Module” on
page 7 - 25.
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Fingerprint Reader Module

See the install procedure in “Fingerprint Reader
Module” on page 7 - 28.

Bluetooth Module

The operating system is the default setting for Blue-
tooth control for the standard V2.0 Bluetooth mod-
ule in Windows 7 and does not require a driver. See
“Bluetooth Module” on page 7 - 34 for configuration
instructions.

A driver is only required for the Combination
Wireless LAN & V3.0 Bluetooth. See “Bluetooth
Combo Driver Installation” on page 7 - 36.

Drivers & Utilities

Driver Installation 4 - 9
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Chapter 5: BIOS Utilities "

Overview BIOS Screens

Note that the BIOS
screens  pictured on
these pages are intend-

This chapter gives a brief introduction to the computer’s built-in software:

ting up your system’s
Configuration: The Setup utility BIOS.

If your computer has never been set up, or you are making important changes to the

: . : : BIOS versi b-
system (e.g. hard disk setup), then you should review this chapter first and note the ~JE¥E tovﬁgﬂ;’tgsnta{;j;‘ge

original settings found in Setup. Even if you are a beginner, keep a record of the set- B ERER EVE R GE =
tings you find and any changes you make. This information could be useful if your FNENSEREES ekl

screens may appear
slightly different from
those pictured on these
There is one general rule: Don’t make any changes unless you are sure of what you pages.

are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

system ever needs servicing.

. |
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4

POST Screen

1.BIOS information
2.CPU type

3.Memory status
4.Enter Setup prompt
appears only during
POST

Note: The POST screen
as pictured right is for
guideline purposes only.
The POST screen on
your computer may ap-
pear slightly different. If
the Boot-time Diagnos-
tic Screen is disabled
(see page 5 - 9 as per the
default setting), the POST
screen will not appear.

Figure5-1
POST Screen

The Power-On Self Test (POST)

If you enable the Boot-time Diagnostic Screen in the Setup Utility, each time you
turn on the computer the system takes a few seconds to conduct a POST, including
a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

Phoenix SecureCore (tm) Desktop

Copyright 1985-2009 Phoenix Technologies Ltd.
All Rights Reserved

BIOS Revision: **k*kk¥*

KBC/EC Firmware Revision: *k*kkkk*

CPU = 1 Processors Detected, Cores per Processor = 4
Intel (R) Core(TM) CPU Q 720 @ 1.60GHz

2040M System RAM Passed

256 KB L2 Cache per Processor Core

6144K L3 Cache Detected

System BIOS shadowed

Video BIOS shadowed 9

Press <F2> to enter SETUPe

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

¢ Press <F1> to resume
e <F2>to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct
configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.

.|
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BIOS Settings
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.

The Setup Utility

The Phoenix Setup utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen in Figure 5- 1 on page 5 - 2 is usually present for a
few seconds after you turn on the system. If you get a “Keyboard Error”, (usually
because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

5 - 4 The Setup Utility
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Setup Screens

The following pages contain additional advice on portions of the Setup. Z
) ) ] Setup Menus
Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screento | Thé  Setup  menus
ke ch to Set shown in this section are
make changes 10 Setup. for reference only. Your
computer's menus will
Instructions on how to navigate each screen are in the box along the bottom of the | indicate the configura- S
screen. If these tools are confusing, press F1 to call up a General Help screen, and “O“daf’pr%p“att_e for your
then use the arrow keys to scroll up or down the page. mocet anc options.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow » next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

The Setup Utility 5 - 5
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Main Menu

Figure5-2
Main Menu

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

. |
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System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

BIOS Revision/VGA Card etc. (Main Menu)
This item contains information on the BIOS version and video card etc., and is not
user configurable.

Main Menu 5 - 7
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™ Advanced Menu
2§

SATA Mode

If you have installed the
Windows 7 operating
system with either AHCI

or RAID mode enabled,
DO NOT disable the set
mode (if you wish to dis-
able the set mode you
will need to reinstall the
Windows 7 OS).

Figure5-3
Advanced Menu

SATA Mode (Advanced Menu)

You may enable/disable SATA RAID or AHCI mode for your hard disks, however
you should only enable/disable SATA RAID or AHCI BEFORE installing an
operating system, and after you have backed up all necessary files and data (see
sidebar).

. |
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Legacy USB Support: (Advanced Menu)

Choose “Enabled” if you intend to use USB devices in systems which do not nor-
mally support USB functionality (e.g. DOS). The default setting is “Enabled” and
does not need to be changed if you intend to use your USB devices in Windows.

Boot-time Diagnostic Screen: (Advanced Menu)

Use this menu item to enable/disable the Boot-time Diagnostic Screen. Enable this
item to display the POST screen (see “The Power-On Self Test (POST)” on page 5
- 2).

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep: (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.

Advanced Menu 5 - 9
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Security Menu

4

Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network  passwords
which will be set in
your software OS.

Figure5-4 ) )
Security Menu Set Supervisor Password (Security Menu)
You can set a password for access to the Phoenix SecureCore Setup Utility. This
will not affect access to the computer OS (only the Phoenix SecureCore Setup

Utility).

.|
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Set User Password (Security Menu)

You can set a password for user mode access to the Phoenix SecureCore Setup
Utility. This will not affect access to the computer OS, (only the Setup utility) unless
you choose to set a Password on Boot (see below). Many menu items in the Phoenix
SecureCore Setup Utility cannot be modified in user mode. You can only set the
user password after you have set the supervisor password.

Password on boot (Security Menu)

Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Security Menu 5 - 11
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Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled®), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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Boot Menu

Figure5-5
Boot Menu

2NZ
Z &

BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
Sk e When you turn the computer on it will look for an operating system (e.g. Windows
CLIE el ER BT 7) from the devices listed in this menu, and in this priority order. If it cannot find
s e s e 8 the operating system on that device, it will try to load it from the next device in the

slightly different from e . .. e . . .
those pictured on these order specified in the Boot priority order. Item specific help on the right is avail-

pages. able to help you move devices up and down the order.

. |
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Exit Menu
Figure5-6
Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

. |
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Chapter 6: Upgrading The Computer

Overview ™

This chapter contains information on upgrading the computer. Follow the steps out- ‘ _

lined to make the desired upgrades. If you have any trouble or problems you can con- Warranty Warning

tact your service representative for further help. Before you begin you will need: Please check with your
- . i tati

* Assmall crosshead or Phillips screwdrlver' Eﬁ;{,‘r‘f un:jefrzziﬁ:;a;xs

» Asmall regular slotted (flathead) screwdriver upgrade procedures to

e An antistatic wrist strap find out if this will VOID

your warranty.

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

* Removing the Battery

» Upgrading the Hard Disk Drive(s)

» Upgrading the System Memory (RAM) - 1
» Upgrading the System Memory (RAM) - 2
» Upgrading the Optical (CD/DVD) Device

Please make sure that you review each procedure before you perform it.

. |
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\ A/
L&
Power Safety Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-

ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

6 - 2 Overview

When Not to Upgrade

These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.You should not perform any of these upgrades if:

* Your system is still under warranty or a service contract
* You don’t have all the necessary equipment

* You’re not in the correct environment

* You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

S
Z

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.

Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.
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Removing the Battery ™
If you are confident in undertaking upgrade procedures yourself, for safety reasons ’Zl‘
it is best to remove the battery.

1. Turn the computer off and turn it over.
2. Loosen screws @ - @ and carefully lift the battery @ up.
3. Remove the battery from the battery bay.

Warranty Warning

Please check with your
service representative

before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 -1
Battery Removal

Removing the Battery 6 - 3
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o Upgrading the Hard Disk Drive(s)

\ A/

’Ll\ The hard disk drive(s) can be taken out to accommodate other 2.5 serial (SATA)
SRS EIIEIUEE  hard disk drives with a height of 9.5mm (h) (see “Storage” on page D - 3). Follow
NE ke nure s your operating system’s installation instructions, and install all necessary drivers
fore you begin make sure: and utilities (as outlined in “Drivers & Utilities” on page 4 - 1), when setting up a

You have backed up any .
data you want to keep from new hard disk.

your old HDD. .
You have all the CD-ROMs 1. Turn off the computer, and turn it over and remove the battery.

and FDDs required to in- 2. Locate the hard disk bay cover and remove screws o & 9
stall your operating system

and programs.

If you have access to the in-

ternet, download the latest

application and hardware

driver updates for the oper-

ating system you plan to in-

stall. Copy these to a

removable medium.

Figure 6 - 2
Component Bay
Cover Screws

6 - 4 Upgrading the Hard Disk Drive(s)
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Upgrading The Computer

Remove the hard disk bay cover @.

Remove screws @ - @ from the hard disk assembly.

Remove the hard disk assembly by pulling the tab to disconnect it from the
connector .

Figure 6 - 3
9 6 @ Bay Cover Removal

& Hard Disk
Assembly Screws

0 O

Upgrading the Hard Disk Drive(s) 6 - 5
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6.

o

Figure 6 - 4
Hard Disk(s)
Removal

Remove screws @ - @ (depending on how many hard disks you have installed in
the assembly).

Separate the hard disk board @D from the case .

Separate the hard disk(s) @& & @ from the case.

Reverse the process to install any new hard disk(s).

®
® o
®
® @
®
® e @
®
®
@
®

6 - 6 Upgrading the Hard Disk Drive(s)
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Removing the Hard Disk in the Secondary HDD Bay

1. Turn off the computer, and turn it over and remove the battery.
2. The secondary hard disk bay is located under the battery compartment.
3. Remove screws @ - @.
4. Slide the hard disk assembly in the direction of the arrow @9.
5. Lift the hard disk assembly @ out of the compartment.
6. Remove the screws €D - € to release the hard disk from the case €®.
7. Reverse the process to install any new hard disk(s).
Figure 6 -5
@ @ @ Secondary HDD
(35) (34) Removal
@
@ D @
50)
D

Upgrading the Hard Disk Drive(s) 6 - 7
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Upgrading the System Memory (RAM) - 1

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-
DIMM) DDR 111 (DDR3) type memory modules (see “Memory” on page C - 2).
The total memory size is automatically detected by the POST routine once you turn
on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws @ - @

Figure 6 - 6
Component Bay
Cover Screws
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3. Carefully (afan and cable are attached to the under side of the cover) lift up

the bay cover.
4. Carefully disconnect the fan cable @, and remove the cover @.

(6] Figure 6 -7
Component Bay
0 Cover Removal

&
e

5. Loosen the heat sink screws in the order indicated @ - @.

® O Figure 6 -8

Heat Sink Screws

0 o

Upgrading the System Memory (RAM)-1 6 - 9
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6. Carefully (it may be hot) remove the heat sink @

Figure6-9
Heat Sink Removal

®
AN

Contact Warning

Be careful not to touch
the metal pins on the

module’s connecting . .
S0 =Sl 7 Gently pull the two release latches (@@ & @) on the sides of the memory socket in

hands have oils which the direction indicated below.

can attract particles, and 8. The RAM module @ will pop-up, and you can remove it.
degrade the module’s

performance. @

Figure 6 - 10
RAM Module
Removal

6 - 10 Upgrading the System Memory (RAM) - 1
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12.

13.

Upgrading The Computer

Pull the latches to release the second module if necessary.

Insert a new module holding it at about a 30° angle and fit the connectors firmly
into the memory socket.

The module’s pin alignment will allow it to only fit one way. Make sure the module
is seated as far into the socket as it will go. DO NOT FORCE the module; it should
fit without much pressure.

Press the module in and down towards the mainboard until the socket levers click
into place to secure the module.

Replace the heat sink (make sure you tighten the screws in the order indicated on
the label as below).

Figure 6 - 11

Heat Sink Insertion

Upgrading the System Memory (RAM) -1 6 - 11
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14. Replace the component bay cover and make sure you reconnect the fan cable
(see Figure 6 - 7 on page 6 - 9).

15. Replace all the component bay cover screws.

16. Restart the computer to allow the BIOS to register the new memory configuration

as it starts up.

.|
6 - 12 Upgrading the System Memory (RAM) - 1



Upgrading The Computer

Upgrading the System Memory (RAM) - 2

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-
DIMM) DDR 111 (DDR3) type memory modules (see “Memory” on page D - 2).
The total memory size is automatically detected by the POST routine once you turn

on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Remove screws @ & @ from the bottom of the computer.

0 e Figure 6 - 12
Bottom LED Cover
Module Screws

.|
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3. Turn the computer over, open the Lid/LCD, and carefully (a cable is connected to
the underside of the LED cover module) unsnap up the LED cover module from
point @ on the right.

Figure 6 - 13
LED Cover Module
Removal
4. Lift up the LED cover module @ and disconnect cable @.
Figure 6 - 14
LED Cover Module @

Cable Disconnect
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5. Remove screws @ - @ from the keyboard.

(6] o o [ 9] ®
Figure 6 - 15

Keyboard Screws

6. Carefully lift the keyboard up, being careful not to bend the keyboard ribbon cable.
7. Disconnect the keyboard ribbon cable € from the locking collar socket @.

® Figure 6 - 16
Disconnect the
Keyboard Locking
Collar

®

Upgrading the System Memory (RAM) -2 6 - 15



Upgrading The Computer

8. Remove the keyboard @®.

Figure 6 - 17
Keyboard Removal
®
b 9. Remove screws @ - @ from the keyboard shielding plate @®.
4]
o 9
Figure 6 - 18 ®
Keyboard Shielding
Plate Removal
®

6 - 16 Upgrading the System Memory (RAM) - 2



Upgrading The Computer

10. Gently pull the two release latches (@ & @) on the sides of the memory socket in
the direction indicated below.
11. The RAM module @D will pop-up, and you can remove it.
Figure 6 - 19
® RAM Module
Removal

21 YN
7. \Y

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting

@ edge. Even the cleanest
hands have oils which
12. Pull the latches to release the second module if necessary. can attract particles, and
13. Insert a new module holding it at about a 30° angle and fit the connectors firmly degrade the module’s
into the memory socket. performance.
14. The module’s pin alignment will allow it to only fit one way. Make sure the module LED Module Cable
is seated as far into the socket as it will go. DO NOT FORCE the module; it should
fit without much pressure. Make sure you recon-
15. Press the module in and down towards the mainboard until the socket levers click nect the LED Module
into place to secure the module. cable 5 (see
16. Replace the screws, shielding plate and keyboard (make sure you reconnect the ).

keyboard cable).

Upgrading the System Memory (RAM) -2 6 - 17



Upgrading The Computer

17. Snap the LED cover module down at the top of the module at points @3 & 9.
18. Push the LED cover module down on the left side at point @, and then slide the
module to the right (as illustrated) and snap down to secure it in place.

D ®

b Figure 6 - 20

LED Cover Module
Slide to the Right &
Snap Down

19. Replace the screws on the bottom of the computer (see Figure 6 - 12).
20. Restart the computer to allow the BIOS to register the new memory configuration
as it starts up.
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Upgrading The Computer

Upgrading the Optical (CD/DVD) Device

1.

2.
3.

4.

Locate the hard disk bay cover and remove screws @ & @.

Remove the hard disk bay cover @.

Remove the screw at point Q and use a screwdriver to carefully push out the
optical device at point @.

Reverse the process to install any new optical device.

Figure 6 - 21
9 Removing the CD/
DVD Device
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Upgrading The Computer
Upgrading the Video Card

If you intend to upgrade or add another VGA card follow the procedures outlined
here. However please check with your service representative first to make sure your
SEEES R SVIGRTEEISY  computer can support more than one video card, and that you are not going to void
S IS your warranty. Pay careful attention to the alignment of any video card into the slot

before undertaking any .
upgrade procedures to on the mainboard.

find out if this will VOID
your warranty.

SN
A&

Warranty Warning

1. Turn off the computer, and turn it over and remove the battery.

2. Locate the component bay cover and remove screws @ - @

3. Carefully (a fan and cable are attached to the under side of the cover) lift up
the bay cover.

Figure 6 - 22 .
4. Carefully disconnect the fan cable @), and remove the cover @.
Component Bay y 6 o

Cover Screws &
Cover Removal @

2N\L
— ®© e O (5]

Fan Cable

Make sure you recon-

nect the fan cable 6 @
before screwing down

the bay cover.
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Upgrading The Computer

5. Remove screws @ - @ (two video cards are pictured here) from the video card
fan(s) and disconnect the fan cable(s) @ (if two cards are present).
6. Remove the RAM fan(s) @.

Figure 6 - 23
Video Card Fan
Screws

® ZAS
Caution

The heat sink, and video
card area in general,

contains parts which are
subject to high tempera-
@ @ tures. Allow the area
time to cool before re-
moving these parts.

Figure 6 - 24
Video Card Fan
Removal
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Upgrading The Computer

7. Remove screws @ - @ from the heatsink in the order indicated on the label
ﬁ (two video cards are pictured here). _
- 8. Grip the handle @@ and carefully remove the heatsink @@.

9. Remove screws @ - @ from the video card.

The heat sink, and video
card area in general,

contains parts which are
subject to high tempera-
tures. Allow the area @ @ @ @
time to cool before re-

moving these parts. @ @

Figure 6 - 25
Heatsink Removal @ @
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Upgrading The Computer

10. Carefully remove the video card @M.

SN
L&

Caution

@ @ The heat sink, and video
card area in general,

contains parts which are
subject to high tempera-
tures. Allow the area
time to cool before re-
moving these parts.

Figure 6 - 26
Video Card Removal

.|
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Upgrading The Computer
™ Installing a New Video Card
28

Contact Warning

1. Prepare to fit the video card into the slot by holding it at about a 30° angle.

Be careful not to touch
the metal pins on the
VGA card’s connecting

edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

Figure 6 - 27
Video Card
Insertion

2. The card needs to be fully into the slot, and the video card and socket have a
guide-key and pin which align to allow the card to fit securely.
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Upgrading The Computer

3. Fit the connectors firmly into the socket, straight and evenly.
4. DO NOT attempt to push one end of the card in ahead of the other.

Figure 6 - 28
Video Card Insertion
Procedure

5. The card’s pin alignment will allow it to only fit one way. Make sure the module is
seated as far into the socket as it will go (none of the gold colored contact
should be showing). DO NOT FORCE the card; it should fit without much
pressure.
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Upgrading The Computer

Secure the card with screws @ - @ (Figure 6 - 25 on page 6 - 22).

7. Place the heatsink back on the card, and secure the screws in the order indicated
in Figure 6 - 25 on page 6 - 22.

8. Attach the video card fan and secure with the screws as indicated in Figure 6 - 23
on page 6 - 21.

9. Reinsert the component bay cover, and secure with the screws as indicated in

Figure 6 - 22 on page 6 - 20 (make sure you reconnect the fan cable before

screwing down the bay cover).

o

.|
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Modules

Chapter 7. Modules

Overview

This chapter contains the information on the various modules (some of which are
optional) which may come with your computer, depending on the configuration
purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

» Setting Up SATA RAID Mode
*  Wireless LAN Module

» PC Camera Module

e TV Tuner Module

» Fingerprint Reader Module

¢ Bluetooth Module

. |
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RAID Hard Disks

All hard disks in a RAID
should be identical (the

same size and brand) in
order to prevent unex-
pected system behavior.

Setting Up SATA RAID Mode

You may use your identical (see sidebar) hard disks (if you have included more than
one hard disk in your purchase option) in combination with Striping (RAID 0), Mir-
roring (RAID 1) or Parity Across Disks (RAID 5) for fault tolerance and data recov-
ery (see Table 7 - 1, on page 7 - 3).

To configure your system in Striping (RAID 0) or Mirroring (RAID 1) modes you
will require at least two hard disks; to configure your system in Parity Across Disks
(RAID 5) mode you will require three hard disks installed.

Intel® Matrix Storage Manager

Make sure you install the Intel Matrix driver and application if you have set up your
hard disk(s) in RAID mode (see “Intel® Matrix Driver Installation” on page 7 - 7).
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RAID Level Description Table7 -1
Identical drives reading and writing data in parallel to increase performance. RAID 0 RAID Levels
RAID 0 implements a striped disk array and the data is broken into blocks and each block is

written to a separate disk drive.

4

Identical drives in a mirrored configuration used to protect data. Should a drive that is

RAID 1 part of a mirrored array fail, the mirrored drive (which contains identical data) will Array Types
handle all the data. When a new replacement drive is installed, data to the new drive is
rebuilt from the mirrored drive to restore fault tolerance. A Mirrored Array

(RAID 1) provides full
data protection, as
data can simply be
copied from a healthy
disk to a replacement
Prepare the following before setting up your serial ATA hard disks in RAID mode: for any failed disk.

A  Striped Array
(RAID 0) is NOT fault-

Identical drives (at least three drives must be used) in a parity across disks
RAID 5 configuration are used to protect data and increase performance. A RAID 5 array
can withstand a single disk failure without losing access to data.

1. The Microsoft Windows 7 OS DVD.

2. A second (identical) hard disk installed in the Primary HDD bay. tolerant. The failure of
OR one drive will result in

A second (identical) hard disk installed in the Primary HDD bay, and a third the loss of all data in
(identical) hard disk in the Secondary HDD bay for RAID level 5. the array. It is de-

3. The Device Drivers & Utilities + User’s Manual disc. signed to increase disk
performance by

spreading the I/O load
across the channels
and drives.
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SATA RAID Setup Procedure (BIOS)

1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select "SATA Mode" and press Enter (see page 5 - 8).

Select “RAID”.

3. Press Esc and go to the Boot menu.

4. Set the DVD-ROM Drive (make sure the Microsoft Windows 7 OS DVD is
inserted) as the first device in the boot order from the Boot menu.

5. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and
press Enter to exit the BIOS and reboot the computer.

6. See the instructions in “RAID Setup (Intel Matrix)” on page 7 - 5.
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RAID Setup (Intel Matrix)
1. As the computer starts up press Ctrl + i to enter RAID configuration menu.

Intel(R) Rapid Storage Technology - Option ROM v9.5.0.1008 -
Copyright (C) 2003-09 Intel Corporation. All Rights Reserved. Flgure 7 - 1

Intel(R) Rapid
Storage Technology
Option ROM

RAID Volumes:
None Defined

Physical Devices:

Port//Drive Model Serial # Sizel Type/Status (Vol ID)
2 FUJITSU MHY2120B//K404T812P22B 111.76B0

4 FUJITSU MHY2120B K404T7C2KJ14 111.7GBO 0

[ V] Change [TAB] -Next [ESC] -Previous Menu [ENTER] -Select

2. Select 1.Create RAID Volume and press Enter.

3. Type the RAID volume name and then press Tab or Enter to advance to the next
field.

Specify (use the up and down arrow keys) the RAID level (see Table 7 - 1, on
page 7 - 3) and then press Tab or Enter to advance to the next field.

Press Enter and the system will select the physical disks to use.

Press Enter and select (if applicable) the Strip Size (best set to default).

Press Enter and select the Capacity size (best set to default).

Press Enter to select Create Volume.

Press Enter to create the volume, and confirm the selection by pressing V.

»

© NG
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10. This will now return to the main menu.

Intel (R) Rapid Storage Technology - Option ROM - 9.5.0.1008
Copyright (C) 2003-09 Intel Corporation. All Rights Reserved.

i - - Recovery Volume Options
Flgure 7 2 2. Delete RAID Volume . Acceleration Options
RA'D Created 3. Reset Disks to Non-RAID . Exit

RAID Volumes:
ID Name Level Size Status Bootable
0 MyRAID RAIDI1 (Mirror) 111.7GB0O Yes

Physical Disks:

Port//Drive Model Serial # Size Type/Status (Vol ID)
2 FUJITSU MHY2120B[ K404T812P22B 111.76BO
. 4 FUJITSU MHY2120BK404T7C2KJ14 111.7GB0O ]

[™V] - select [ESC]-Exit [ENTER] -Select Menu

11. Select 6.Exit and press Enter, then press Y to exit the RAID configuration menu.

12. Make sure the Windows 7 OS DVD is in the DVD drive. and as the computer
starts up it will automatically boot from the Windows 7 OS DVD.

13. Click Next to continue installing the operating system as normal (see your
Windows documentation if you need help on installing the Windows OS).

14. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual
disc as per Table 4 - 1, on page 4 - 3 (make sure you install the Intel Matrix driver
- see “Intel® Matrix Driver Installation” on page 7 - 7).

7 - 6 Setting Up SATA RAID Mode



Modules

Intel® Matrix Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/ 4

DVD drive. _ e-SATA Port
2. Click Option Drivers (button). _
3. Click 5.Install Matrix Driver > Yes. Install the Intel Matrix
4. Click Next > Next > Yes > Next. Slt;raf’hee ig‘f’gr r;;:\'/zl
5. Click Finish to restart the computer. ipcoz for e-SATA devices

The Intel Matrix Storage Console displays status information on your RAID con- | ™ the taskbar

figuration. Run the Intel® Matrix Storage Console from the Intel® Matrix Stor-
age Manager in the Programs/All Programs menu. The Intel® Matrix Storage

Manager provides information on the RAID status.
Figure 7 -3
Intel Matrix Storage
Console
(Basic & Advanced
Views)

|
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Intel® Matrix Storage Manager
If a hard drive member of a RAID volume is reported as “Degraded” or “Failed” it
may be possible to recover the volume. If the volume cannot be restored then you
will need to recreate the RAID volume and restore the data from a back up. The Help
menu (press F1 or select Contents and Index from the Help menu) provides in-
structions on how to recover or recreate RAID Volumes.

Figure 7 -4
Intel Matrix Storage
Manager Help

.|
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RAID Volume Data Verification and Repair

The RAID volume data verification process identifies any inconsistencies or bad
data on a RAID 0, RAID 1 or RAID 5 volume. The table outlines what occurs for

each RAID level:

Replacing and Reverting Recovery and Master Volumes

Modules

RAID . . .
Verif Verif Repair
Level erify erify & Repa
RAID 0 Bad blocks are identified. N/A
Bad blocks are reassigned.
Bad blocks are identified. If the data on the mirrored drive does not Table 7 -2
RAID 1 Data on the mirrored drive is compared to match the data on the source drive, the C
data on the source drive. data on the mirrored drive is overwritten by RAID Verification &
the data on the source. Repair Status
Bad blocks are identified. Bad blocks are reassigned.
RAID 5 Parity is recalculated and compared to the If the newly calculate_d parity does not‘ .
- . match the stored parity, the stored parity is
stored parity for that stripe. . . .
overwritten with the newly calculated parity.

If a master or recovery drive fails you will need to add a new identical drive and re-
build the recovery volume to the drive. You can also revert the master drive to the
state of the previous volume update. For details on how to do this see “Intel Matrix
Storage Manager Help” on page 7 - 8.

See over for details on how to verify and repair RAID volume data.
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Verifying and Repairing RAID Volume Data

1. Runthe Intel® Matrix Storage Console from the Intel® Matrix Storage Man-
ager in the Programs/All Programs menu.

2. Click View > Advanced Mode.

3. Right-click on the RAID volume and select either Verify Volume Data or Verify
and Repair Volume Data.

Figure 7 -5
RAID Verification
(Intel® Matrix
Storage Console)

»

The verification or verification and repair process will run and display progress.
5. A dialog box will display the final status of the verification or verification and repair

Figure 7 - 6 status.

Verification Status
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Wireless LAN Module

If you have included an Intel® Wi-Fi Link 5300 Series, Intel® Advanced N Wi-Fi

Link 6200, Intel® Ultimate N Wi-Fi Link 6300 module or 3rd Party 802.11b/g/n e e
. R ] peration Aboard
WLAN module in your purchase option, make sure that the Wireless LAN module D et

is on before installing the driver. Wireless should be turned ON in the Windows
e . . . PPN The use of any portable
Mobility Center to ensure proper wireless function key behavior (see “Wireless EESEEEEEEEaiis i

Hot Keys” on page 7 - 16). vices aboard aircraft is usu-
ally prohibited. Make sure

Use the Fn + F11 key combination or Touch Sensor Instant Key to toggle power e A S B L

you are using the computer

to the Wireless LAN module. When the WLAN module is powered on, the aboard aircraft.

LED will be highlighted and the indicator will briefly be displayed. Make sure  BRFSSRSESRESEAR
you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. The operat- bination/Touch Sensor Key
ing system is the default setting for Wireless LAN control in Windows 7. o loale aner Go (0

WLAN module, and check
the LED to see if the mod-
ule is powered on or not
(see

/

).
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Intel® Wi-Fi Link Series Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1. Make sure the module is powered on, then insert the Device Drivers & Util-
ities + User’s Manual disc into the CD/DVD drive.

2. Click Option Drivers (button).

3. Click 1.Install Wireless Lan Driver > Yes.

4. An on-screen message will appear to show the progress of the WLAN
installation.

5. When the message disappears the driver will be installed.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows 7 (see overleaf).

802.11b/g/n Driver Installation

1. Make sure the module is powered on, then insert the Device Drivers & Util-
ities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 1.Install Wireless Lan Driver > Yes.

Choose the language you prefer and click Next.

Click Next > Install.

Click Finish to restart the computer.

SouhrwN

Note: The operating system is the default setting for Wireless LAN control in Win-
dows 7 (see overleaf).

. |
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Connecting to a Wireless Network in Windows 7

Make sure the Wireless LAN module is turned on. e

1. Click the taskbar wireless icon H and then double-click an access point to con- Network and
nect to or click to Open Network and Sharing Center if you do not see a network Sharing Center
you want to connect to in the taskbar menu (a list of options will appear allowing

setting changes, and creating a new network). \Tvzlr’lfznnzlsghu;ﬁ;ge c’:\leer:-

ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 -7
Click Taskbar Icon
Menu & Network
and Sharing Center
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2. You may need to enter a security key for any access point to which you are trying
to connect.

3. Click to select a network location (e.g. Home, Work or Public).

4. Click “View or change settings in Network and Sharing Center” to access
further options for the connection.

Figure 7 - 8
Network Location
Set
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5. Click the taskbar icon 4| to see any currently connected networks.
6. To disconnect from the wireless network you can click the taskbar wireless icon |,

click the active connection and then click Disconnect (button). Security Enabled

Networks

You should try to make

sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure
networks may allow unau-
thorized access to your
computer, documents,
websites and files etc.

Figure7-9
Click Taskbar Icon
Menu - Disconnect
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Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for
Wireless Hot Keys information on battery status, power plans used and wireless device status etc.

WSSl To access the Windows Mobility Center:
function keys will not func- . . . . .
tion properly if Wireless is 1. Click Start, and click Control Panel (or point to Settings and click Control

turned OFF in the Win- Panel).
dows  Mobility ~Center 2. Double-click Windows Mobility Center (Mobile PC).

BRIl [FEE 3. Click the button to Turn wireless off/on, or click the icon  to access the network
The wireless indicators menu.
I nay show that
the WLAN module is pow- 4
ered on, however if wire- . -
less is OFF in the Mobility Windows Mobility
Center, the module will not Center
el The Windows Mobili-
Make sure that Wireless is ty Center control pan-
ON in the Mobility Center to el provides an easy
ensure proper function key point of access for in-
behavior. formation on battery
status, power plans
. used and wireless de-
Figure 7 - 10 _ _ _ _ vice status etc.
windows Mobility Make sure Wireless is ON to ensure proper function key behavior.

Center
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PC Camera Module

Before installing the driver, make sure the PC Camera is on. Use the Fn + F10 key

combination or Touch Sensor Instant Key to toggle power to the to the PC Camera LAIESERE Camera

Driver Information

module. When the PC Camera module is powered on, the LED will be high- ‘ !

lighted and the indicator will briefly be displayed. Make sure you install the ~JSiEES IR SllES
. . .- . & Utilities + User’s Manu-

drivers in the order indicated in Table 4 - 1, on page 4 - 3. al disc and any accompa-

nying insert pages, for the
There are a number of different camera modules available with this computer model ~ JEESSR SRR
series. You will have the appropriate application installed for your camera (note that which may override the in-
some versions of the camera application do not support the zoom function). Make formation provided here.

sure you access the application via the desktop shortcut.

PC Camera Display

The PC Camera applica-
tion software needs to be
run while the default note-
book LCD is the selected
display device.

After a camera picture is
obtained on the default
notebook LCD, you may
then use the Fn + F7 to tog-
gle through the display
modes (give the screen
time to refresh).

. |
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PC Camera Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

2. Click Option Drivers (button).

3. Click 2.Install WebCam Driver > Yes.

4. Choose the language you prefer and click Next > Next > Finish.
OR
Choose the language you prefer and click Next > Next > Finish to restart
the computer.
OR
Click Next > Next > Install > Finish to restart the computer.
OR
Click Next > Install > Finish to restart the computer.

5. Run the camera application program from the desktop shortcut (if the hard-
ware is turned off use the Fn + F10 key combination to turn it on again).

. |
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PC Camera Audio Setup

If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

Click Start, and click Control Panel (or point to Settings and click Control Panel).

Click Sound (Hardware and Sound).

Click Recording (tab).

Right-click Microphone (Realtek High Definition Audio) and make sure the item is

not disabled.

Double-click Microphone (or select Properties from the right-click menu).

Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to

the level required.

Click OK and close the control panels.

Run the camera application program from the desktop shortcut.

9. Go tothe Devices menu heading and select Microphone (Realtek....) (it should
have a tick alongside it).

10. Go to the Capture menu heading and select Capture Audio (it should have a tick

alongside it).

o0 bRk

~

©
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Figure 7 - 11
Audio Setup for PC
Camera

Right-cli/
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Camera Application
The camera application is a video viewer for general purpose video viewing and test- 4

ing, and for capturing video files to .avi format. _ _
Pre-Allocating File

1. Runthe camera application from the desktop shortcut (it is recommended that you SIAEEEE
set the capture file before the capture process - see below). You may pre-allocate the
2. Gotothe Capture menu heading (if you wish to capture audio check “PC Camera file size (File > Allocate
Audio Setup” on page 7 - 19) and select Start Capture. File Size/Space) for the
3. Click OK/Yes (the file location will be displayed in the pop-up box) to start capture file in the camera
capturing the video, and press Esc to stop the capture (you can view the file using program (you may need

to set a folder location
first).

Set Capture File Pre-allocating space on

Prior to capturing video files you may select the Set Capture File... option in the | the hard disk canimprove

r : . . . . ] the capture quality (par-
File menu, and set the file name and location before capture (this will help avoid ac ticularly of large capture

cidentally overwriting files). Set the name and location then click Open, then setthe | fies), by reducing the
""Capture file size:" and click OK. You can then start the capture process as on the | amount of work the hard

previous page. disk has to do in finding
space for the video data

as it is being captured.

the Windows Media Player).

Note the important information in “Reducing Video File Size” on page 7 - 22 in

order to save file space, and help prevent system problems. See also “Reducing Vid-
eo File Size” on page 7 -
22.
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Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows system requires a minimum of 15GB of free space on the C:
drive system partition. In order to prevent system problems it is recommended that
you save the captured video file to a location other than the C: drive (see “Set Cap-
ture File” on page 7 - 21), limit the file size of the captured video (see “Pre-Allo-
cating File Size/Space” on page 7 - 21) or reduce video resolution (see below).

To Reduce Video Resolution Qutput Size:

1. Run the camera application program from the desktop shortcut.

2. Go to Options and scroll down to select Video Capture Pin....

3. Click the Output Size drop box and select a lower resolution size in order to
reduce the captured file size.

4. Click OK.

7 - 22 PC Camera Module



Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to

adjust the setting in the Video Capture Filter options. Latest PC Camera

1. Run the camera application from the desktop shortcut. Driver Information

2. Goto Options and scroll down to select Video Capture Filter.... Erea i B B
3. Click either 50Hz or 60Hz under Frequency/Anti Flicker/Powerline Frequency. ers & Utilities + User’s

Manual disc, and any
accompanying insert
pages, for the latest up-
dated information on the
O PC Camera driver,
which may override the

information provided

here, including the fig-
© ures pictured here.

Figure 7 - 12

O © Video Capture Filter
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Zoom
The camera application allows you to zoom the camera in and out (note the zoom
function is not available in all camera model applications).

1. Run the camera application from the desktop shortcut.
2. GotoZoom and select Zoom Out/Zoom In.

Figure 7 - 13
Zoom/Setting

SN
A&

Snapshot Folder

The Snapshot folder's
default location is on the Taking Still Pictures

desktop. Do not move L A
el The camera application allows you to take still pictures.

Lo B 1 Run the camera application from the desktop shortcut.

W EE Al PR 2. Goto Options and select Take Picture.
If you accidentally de- 3. The picture (in JPEG format) will be placed in the Snapshot folder on the
lete or move the folder, desktop.

you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.
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TV Tuner Module

If your purchase configuration includes the optional Hybrid (Analog & Digital)
USB Mini-Card TV Tuner module, you will be supplied with a remote control unit
and appropriate antenna and fittings for the module. Software support for the TV
Tuner module is provided by Windows Media Center in Windows 7 (not included
in Starter or Home Basic versions). A driver is provided on the Device Drivers &
Utilities + User’s Manual disc for the remote control supplied with the TV Tuner.

The optional TV Tuner allows you to watch TV, play music CDs, video conference
and capture still images and video on your PC.

The Cable (CATV) antenna will only be enabled when a TV Tuner module is
installed. Make sure you connect the TV antenna.

TV Antenna

The TV antenna sup-
plied with any TV Tuner
module is intended for
indoor use only. Please

do not use your TV Tun-
er module outdoors.

TV Tuner Remote

Point the remote at the
consumer IR transceiv-
er to change channels
etc.

Figure 7 - 14
TV Tuner Ports/
Jacks

1. Consumer Infra-
red Transceiver

2. CATV Antenna
Jack
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Support

Note that the TV Tuner
module options in Win-
dows 7 is supported by
the Windows Media
Center software which
comes built-in to all the
Windows 7 versions
except Starter and
Home Basic.

If your purchase in-
cludes a TV Tuner op-
tion, and you are re-
configuring your system
for a different system,
you should install any
Windows 7 version ex-
cept Starter and Home
Basic.

Consumer Infrared Driver

1.

arLN

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 3.Install CIR Driver > Yes.

Choose the language you prefer and click Next > Next.

Click Finish to restart the computer.

Windows Media Center

1.

2.

3.
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This TV Tuner module is fully supported by Windows Media Center in
Windows 7 (not included in Starter or Home Basic versions).

Run Windows Media Center directly from the Start menu (Start > Pro-
grams > Windows Media Center).

Windows Help and Support provides information on the Windows Media
Center functions. Click Start  and select Help and Support, and then
type “Media Center” in the Search Help box and click the magnifying
glass icon 2 to bring up the results.




Digital TV Broadcast Signal

The antenna is the most crucial factor in receiving a clear digital terrestrial TV
broadcast signal. The passive antenna provided should provide a clear signal when
placed beside a window. If the signal is not clear then you can purchase an active
antenna (it should also be placed beside a window) to improve the signal. You
should also check with any related government website which provides information
on digital terrestrial TV coverage for your area. Note that (unlike standard analog
TV) if the digital signal is weak then no picture will appear on the TV at all.

TV Recording and Power Plans

If you intend to use the optional TV Tuner to record live TV, then go to the Power
Options control panel and create a power plan (see “Power Plans” on page 3 - 4)
to prevent the power saving options from adjusting the computer’s performance lev-
el.

Remote Control Unit

The remote control unit allows you to remotely start and send the system into a pow-
er saving state, to run Windows Media Center and to navigate the Media Center
menus etc. The remote control unit also gives full control over all TV and video
functions.

. |
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CATV Cable Safety

Make sure that your
CATV system installer
has connected the Co-
axial cable shield to the
grounding system of the
building, as close to the
point of cable entry as
practical.

This reminder is provid-
ed to call the CATV sys-
tem installer's attention
to Article 820-93 of the
NEC (Section 54, Part |
of the Canadian Electri-
cal Code).




Password Warning

If you set passwords for
any of the security mod-
ules, NEVER forget your
password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.

Fingerprint Reader Module

The optional fingerprint reader Protector Suite Software provides a high level
of security for your computer. A further level of security and control is provided in
the B1OS (see “Security Menu” on page 5 - 10).

The fingerprint reader and Protector Suite Software allow you to:

» Access or Lock your computer
 Protect sensitive files

» Display and file your favorite web pages
 Fill in frequently used dialogs

* Run your favorite applications

If you have included the fingerprint reader in your purchase option you will need to
install the driver as per the instructions below.

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the
fingerprint tutorial. To run the tutorial click Start > Programs/All Programs >
Protector Suite QL > Fingerprint Tutorial after installing the driver.
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Fingerprint Reader Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

2. Click Option Drivers.

3. Click 4.Install FingerPrint Driver > Yes.

4. Windows will configure Protector Suite 2009 and automatically restart
the computer.

5. Click the tray icon , scan a finger or click Start > Programs/All Pro-
grams > Protector Suite > Control Center and then begin the enrollment
process (see over).

.|
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User Enrollment

1. Click Start > Programs/All Programs > Protector Suite > Control Center, or
doubile click the taskbar icon (click Initialize).

2. On the first run of the program you will be asked to click the Accept button to
accept the license.

Note that it is strongly rec- 3. Ifyou have not set a Windows password you will be prompted to do so (note: If

ommended that you enroll you have not set a password Protector Suite cannot secure access to your

Fingerprint

Enrollment

more than one finger in computer)

finj tc. . -
s ST 4. Click Submit when you have entered password.

5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get
help with fingerprint enrollment at any time).
Figure 7 - 15
Fingerprint
Enrollment O

Tutorial
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6. Click the button above any of the fingers to begin the enroliment process for that

finger. il’:

7. Swipe the finger until the progress bar reaches 100% to enroll that finger.

Fingerprint
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc.

Figure 7 - 16
Fingerprint
Enroliment

Progress

8. Close the Protector Suite 2009 window.

.|
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9. Right-click the taskbar icon and select Start Control Center (and then swipe a
finger) to allow you to Edit Fingerprints, register Applications, edit Settings and
access the Help menu etc. You can also run the Control Center etc. from the
Protector Suite item in the Programs/All Programs menu

10. Click “Help” to get more information on any topic.

11. You can also run the Tutorial, or Product Tour video to get more information.

Figure 7 - 17
Control Center & C > Help
Biomenu

12. If you swipe your finger over the reader at any time you can access the Biomenu
to lock the computer, register websites, access the Personal Safe, open the
Control Center and access the Help menu.

.|
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Fingerprint Control Center Features

Application Launcher

The Application Launcher allows you to register applications to be launched when
assigned to a particular finger. Simply copy the application icon on to one of the reg-
istered fingers and ten click OK to close the application window. Once registered the
application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other set-
tings for web sites etc.

Personal Safe
The Personal Safe is an encrypted area assigned on your hard drive that allows you
to store files and folders to be protected by fingerprint protection.

.|
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4

Help

For more information on
these and other features
simply access “Help” in
the Fingerprint Control
Center and select the
item from the menu on
the left.



Wireless Device
Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if

you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination/Touch Sensor Key
to toggle power to the Blue-
tooth module, and check
the LED to see if the mod-
ule is powered on or not
(see

/

).

Bluetooth Module

The optional Bluetooth module allows you to connect your computer to Bluetooth
enabled devices such as other computers, desktop computers, mobile phones, print-
ers, digital cameras, PDAs, headsets etc. using a short-range radio frequency.

4

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in
one direction only (simultaneous data transfer is not supported). Therefore if you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use
the key combination (Fn + F12) to power on the Bluetooth module after the computer resumes from
Sleep.
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There are two Bluetooth module options available for this computer. If your pur-
chase option includes the Combination Wireless LAN & V3.0 Bluetooth module
then install the driver as instructed overleaf. Follow the instructions on page 7 - 37
to configure the Bluetooth settings.

If your purchase option includes a standard V2.1 Bluetooth module, then the op-
erating system’s Bluetooth Devices control panel is used to configure the Bluetooth
settings in Windows 7, and therefore does not require a driver. Follow the instruc-
tions on page 7 - 13 to configure the Bluetooth settings from Windows directly.

Use the Fn + F12 key combination or Touch Sensor Instant Key to toggle power
to the Bluetooth module. When the Bluetooth module is powered on, the
LED will be highlighted and the indicator will briefly be displayed.
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Bluetooth Combo Driver Installation
Note this driver is required only for the combo Bluetooth and WLAN module only.

1.

Nooks~wn

o

Make sure the module is powered on, then insert the Device Drivers & Util-
ities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 7.Install Combo BT Driver > Yes.

Choose the language you prefer and click OK.

Click Next.

Click the button to accept the license and click Next.

Click Next > (select if you want to create an icon to appear on the desktop)
Next > Install.

Click Finish.

The My Bluetooth icon  will appear on the desktop and the Bluetooth
item will be installed in the Programs/All Programs menu.
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Bluetooth & WLAN Combo Module Configuration

Setup your Bluetooth Device so the Computer Can Find it 4

1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on. Bluetooth Module &

2. Make the device discoverable (to do this check your device documentation). Resuming From Sleep
Mode

To Turn the Bluetooth Module On

1. Press the Fn + F12 key combination to power on the Bluetooth module. The Bluetooth module’s de-

fault state will be off after re-
suming from the Sleep
power-saving state. Use the

To Add a Bluetooth Device

1. Double-click the My Bluetooth application on the desktop (or access it from the key combination (Fn + F12)
Programs/All Programs menu). to power on the Bluetooth
2. Double-click the device you want to pair with the computer (if no devices appear e L

press F5 or click the Refresh button to search for devices). resumes from Sleep.

Figure 7 - 18
My Bluetooth
Devices
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3. You will then be presented with a menu of options to select from.

Figure 7 - 19

Bluetooth Device
Options

4. Click the appropriate button to connect to the device.
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5.  You may need to allow the connection from your device, and you will then need to
provide a passcode from the device.

6. You can then enter the passcode on the computer and click OK to establish the
connection.

Figure 7 - 20
Bluetooth Pairing
Code & Connection
Established
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Bluetooth Configuration in Windows 7

el | Setup your Bluetooth Device so the Computer Can Find it

Add a Device 1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.

2. Make the device discoverable (to do this check your device documentation).
Click Start, and click

Control Panel and then To Turn the Bluetooth Module On
click  Devices and 1. Pressthe Fn + F12 key combination to power on the Bluetooth module.
Printers  (Hardware | 5 A Byetooth icon ] will appear in the taskbar.

ang Spund). Cligk &l 3. You can then do any of the following to access the Bluetooth Devices control
a device to search for panel

any available Bluetooth
devices. +  Double-click the taskbar icon [3 to access the Bluetooth Devices control panel.

) ) » Click/Right-click the taskbar icon g4 and choose an option from the menu.
If you are experiencing

problems connecting to
some Bluetooth devices
see “Bluetooth Con-
nection Problems” on
page 8 - 15.

Figure 7 - 21
Bluetooth Devices &
Click Icon Menu

Add a device

Right-Click Taskbar Icon EJ
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To Add a Bluetooth Device

1. Access the Bluetooth Devices control panel and click Add a device. /
2. Double-click the device you want to pair with the computer.

Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure 7 - 22

i . . . _ . Add a Device
3. On first connection the computer will provide you with a pairing code to be entered

onto the device.
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4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

Figure 7 - 23 N
Pairing Code Pairing Codes

Example The example outlined here shows a connection to

a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.

o

Windows will check to see if any drivers are required to complete the pairing.

6. Follow any on-screen instructions on the computer if device drivers are required to
be installed.

7. Click Close.

Figure 7 - 24
Pairing Complete &
Bluetooth Device
Enabled
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To Change Settings for the Bluetooth Device
1. Click the taskbar icon and select Show Bluetooth Devices. /
2. Right-click on the device you want to change and click Properties to:

* Change the name of the device (click Bluetooth, type a new name and click OK).
» Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

Bluetooth Help

To get help on Bluetooth
To Make your Computer Discoverable to Bluetooth Devices g‘;gzg“;?l"g; :;?3 asﬁg
1. Cl!ck the Faskbar icon and select Open Settings. _ _ _ Support from the Start
2. Click Options, and make sure that Allow Bluetooth devices to find this

. R menu. Type Bluetooth in
computer check box (Discovery) has a tick inside it. the Search Help box, and

3. Make sure that the Alert me when a new Bluetooth device wants to connect select an item from the re-
check box (Connections) has a tick inside it, if you want to be notified when a turned search results to
Bluetooth device wants to connect. get more information.

Figure 7 - 25
Bluetooth Settings -
Options
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Troubleshooting

Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

» Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip,
make sure it is actually working. Check the LED Power Indicators (see “LED Indicators” on page 1 - 7)
to see the computer’s power status.

» Connections - Check all the cables to make sure that there are no loose connections anywhere.

» Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Configuring the Power Buttons” on page 3 - 8), the Fn + F4 key combi-
nation, or power button to wake-up the system.

» Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness (see Table 1 - 3, on page 1 - 10).

» Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

» Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive
when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the
disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). This is especially important if
you choose to use a Boot password for the SCU (see “Security Menu” on page 5 - 10).

» Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief
notes).

\ A/
L&
Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-

ranty.
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Viruses

Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS’s documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at
least instructions on how to make one).

8 - 4 Viruses



Troubleshooting

Upgrading and Adding New Hardware/Software

» Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

* Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

* When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

» Make sure you have installed the drivers for any new hardware you have installed (latest driver files are
usually available to download from vendor’s websites).

» Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

.|
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» Don’t over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices
and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and
removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.

.|
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Problems & Possible Solutions

Problem

Possible Cause - Solution

You turned the power on
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is present
and seated properly (the design of the battery only allows it to go in one way). Make sure there’s
nothing interfering with the battery contacts.

The Battery LED power
indicator {11 , is blinking
orange.

Low Battery. Plug in the AC power source. If the computer doesn’t start up immediately, turn it off
then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see “Power
Plans” on page 3 - 4) check its settings. You may also be using an ExpressCard device/USB
device/external device that is drawing a lot of power.

You are attempting to run an SLI configuration on battery power. Due to the high power and
system demands created by enabling SLI Configuration, you should not enable SLI
configuration if your computer is powered by battery only.

Actual battery operating
time is shorter than
expected.

The battery has not been fully discharged before being recharged. Make sure the battery is fully
discharged and recharge it completely before reusing (see “Battery Information” on page 3 -
10).

Check the settings of any active power plan (see “Power Plans” on page 3 - 4).

A peripheral device/lUSB device is consuming a lot of power. Turn off/remove the unused device
to save power.
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Problem

Possible Cause - Solution

The computer feels too
hot.

Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the
computer isn't sitting on a thermal surface (see “Overheating” on page 1 - 15). Make sure
you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a travel bag (or any
such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan
intakes to be blocked.

Nothing
screen.

appears on

The system is in a power saving mode. Toggle the Fn + F4 (see “Configuring the Power
Buttons” on page 3 - 8).

The screen controls need to be adjusted. Toggle the screen control Fn + F8/F9 key
combinations. If you're connected to an external monitor, make sure it's plugged in and turned
on. You should also check the monitor’'s own brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key Fn + F7 combination. If
an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on
the external monitor |
have plugged in and
powered on.

You haven't installed the video driver and configured it appropriately from the Control Panel. See
“NVIDIA Video Driver Controls” on page B - 1 for instructions on installing and configuring the
video driver.
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Problem Possible Cause - Solution
You forget the boot | If you forget the password, you may have to discharge the battery of the CMOS. Contact your
password. service representative for help.

AN
Ik

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume control in the Volume Control Panel in the
Windows taskbar, use the key combination Fn + F5 and F6 or move your finger slowly along the
volume control slider to adjust the system volume (see “Audio Features” on page 2 - 15/
“Touch Sensor Instant Keys” on page 1 - 8) to adjust.

The compact disc

cannot be read.

The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

The compact disc tray
will not open when there
is a disc in the tray.

The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject
hole (see “Loading Discs” on page 2 - 3).

The DVD regional
codes can no longer be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5.
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Problem

Possible Cause - Solution

The TouchPad doesn't
work.

The Touchpad has been disabled. Press the Touchpad toggle (Fn + F1) key combination (make
sure you have installed the Touchpad driver.

I am sliding my finger up
and down on the right
side of the TouchPad to
scroll a Window and the
TouchPad does not
respond.

There are different TouchPad versions available on this computer, and this version requires
tapping/holding to scroll. Either tap repeatedly, or hold the finger down, at the top or bottom right
of the touchpad (depending on the scrolling direction required) to scroll the window.

The system freezes or
the screen goes dark.

The system’s power saving features have timed-out. Use the AC/DC adapter, press a key on the
keyboard, or press the sleep (Fn + F4) key combination, or press the power button if no LEDs are
lit.

The system never goes

Power Options features are not enabled. Go to the Windows Power Options menu and enable

into a power saving | the features you prefer (see “Power-Saving States” on page 3 - 6). Make sure you have
mode. enabled Hibernate mode from the control panel.

The Wireless LAN/ | The modules are off. Check the appropriate Touch Sensor indicator to see if the modules are on
Bluetooth/PC Camera | or off (see “Touch Sensor Instant Keys” on page 1 - 8). If the LED indicator is not illuminated,
modules cannot be | then press the appropriate touch sensor instant key/function key combination in order to enable
detected. the modules.

The Wireless LAN/ | The driver(s) for the module(s) have not been installed. Make sure you have installed the driver
Bluetooth/PC Camera | for the appropriate module (see the instructions in Chapter 7 “Modules” for the appropriate
modules cannot be | module).

configured.
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show that the WLAN
module is powered on,
however the module
does not connect.

Problem Possible Cause - Solution
The  Wireless LAN | The WLAN module is turned off in the Windows Mobility Center. The computer’s wireless
indicators function keys will not function properly if Wireless is turned OFF in the Windows Mobility

Center control panel. Make sure that Wireless is ON in the Mobility Center to ensure proper
function key behavior (see “Wireless Hot Keys” on page 3 - 11).

When a DVD is played in
Windows Media Player/
Media Center, the audio
track in other languages
(commentaries etc.) is
not clear if connected to
the S/PDIF-Out Jack.

This is an issue with Windows Media Player/Media Center and audio output through the S/PDIF-
Out Jack. We recommend that you use the Power DVD application to play DVDs.

Nothing appears on the
screen when the PC
Camera software is run.

You have selected an external display as the default display device. The PC Camera application
software needs to be run while the default notebook LCD is the selected display device.

After a camera picture is obtained on the default notebook LCD, you may then use the Fn + F7 to
toggle through the display modes (give the screen time to refresh).

If you have selected an external display as your display device do not run the PC Camera
software application until you have switched back to the notebook LCD.
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Problem

Possible Cause - Solution

A file cannot be copied
to/from a connected
Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is supported in one
direction only (simultaneous data transfer is not supported). If you are copying a file from
your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth
enabled device to your computer until the file transfer process from the computer has been
completed

The Bluetooth module is
off after resuming from
Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state.
Use the key combination (Fn + F12) to power on the Bluetooth module after the computer
resumes from Sleep.

No sound can be heard

You have not configured the HDMI audio output. See “HDMI Audio Configuration” on page 2 -

connected to the DVI-
Out port.

through an HDMI | 12.

connected display

device.

You are experiencing | Where this is the case, install the beta video driver version provided on the Device Drivers &
problems with an | Utilities +User’s Manual disc.

external display

1. Insert the Device Drivers & Utilities + User’s Manual disc and click Browse
CD/DVD.

2. The driver is located in the following location on the disc:
Driver\02_Video(Beta)\.

3. Double-click the executable setup file and follow the on-screen instructions to
install the driver.
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Problem

Possible Cause - Solution

After using the Fn + F11
key  combination to
switch the WLAN module
off and have, restarted
the computer, shut the
computer down and
started up again, or
recovered from hibernate
mode, you experience
problems with powering
the WLAN module on
again.

This is a known problem and Intel have provided a beta WLAN driver to address this issue. The
beta WLAN driver is provided on the Device Drivers & Utilities +User’s Manual disc.

1.

2.

Insert the Device Drivers & Utilities + User’s Manual disc and click Browse

CD/DVD.

The driver is located in the following location on the disc:
Others\01_WLan\Shirley(Beta)

Use the Fn + F11 key combination to power ON the WLAN module before
installing the driver (check the LED indicator to make sure the WLAN module is

ON).

Double-click the executable setup file and follow the on-screen instructions to

install the driver.
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Troubleshooting

Problem Possible Cause - Solution

You have a RAID | You may need to recover the RAID volumes.

enabled and the system | 1 Ag the computer starts up press Ctrl + i to enter RAID configuration menu

will not boot to Windows. 2. If the RAID volume’s Physical disks are marked in red, then press 4.Recovery
Volume Options.

3. Ifyou cannot access 4.Recovery Volume Options (i.e. itis grayed out) then press
5.Acceleration Options.

4. Press Enter and return to the main menu, then press 4.Recovery Volume
Options.

5. Follow the on screen instructions to recover the Physical disks.

6. If only one of the physical disks now appears green, then press 6.Exit to save the
changes and exit and boot to Windows.

7. When Windows is loaded run the Intel® Matrix Storage Console from the Intel®

Matrix Storage Manager in the Programs/All Programs menu.

Click View > Advanced Mode.

9. Right-click on the RAID volume and select either Verify Volume Data or Verify
and Repair Volume Data.

10. The verification or verification and repair process will run and display progress.

11. A dialog box will display the final status of the verification or verification and repair
status.

©

. |
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Bluetooth Connection Problems

If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and
headsets) it maybe necessary to download and install the Windows Mobile Device Center software (for Win-
dows Vista and Windows 7). Go to the Microsoft website and search for the Microsoft Windows Device Center
Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver.

Install the Microsoft Windows Device Center Driver as appropriate for your operating system.

Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
Make sure the Bluetooth device is powered on.

Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and
Printers).

Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have
connected, or tried to connect to, a Bluetooth device previously).

PwDNPE

o

2¥ MNetwork adapters /
'3 Atheros ARS007EG Wireless Network Adapter
l&-"‘ Bluetooth Device (Personal Area Network)
5;-“ Bluetooth Device (RFCOMM Protocol TDI)

A

Bluetooth Peripheral Devices

l;‘ Marvell Yukon 88E8040 PCI-E Fast Ethernet Contreller You will need to repeat the procedure
4-llp Other devices : listed here for all Bluetooth Peripher-
i 4|7 Bluetooth Peripheral Device q A q

W PCIFLASH Memory .a| DeV|.ces listed under Other Devices
o) Processors i.e. until there are no more Bluetooth
>~ Sound, video and game controllers Peripheral Devices listed under this
P - Storage controllers menu heading_

ol Suertarn Asicar

Figure 8 - 1 - Device Manager

. |
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Troubleshooting
6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.

7. Click Browse my computer for driver software.
8. Click Let Me pick from a list of device drivers on my computer.

Figure 8 - 2 - Browse my computer.../Let me pick from...
9. Select Bluetooth Radios from the list.

>

Figure 8 - 3 - Select Bluetooth Radios
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Troubleshooting

10. A list of drivers will appear with Manufacturer on one side and Model in the other.
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not

choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for
Microsoft Corporation to appear in the list).

12. Select Windows Mobile-based device support from the Model list.

@ || Update Driver Software - Bluetooth Peripheral Device

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Next. If you have a
disk that centains the driver you want to install, click Have Disk.

Manufacturer || Model

Microlink Rl Windows Mobile-ba evice support

D) it L ——
Microsoft Corporation
e Toess

Make sure you select C
Microsoft Corporation

MAT o Cio.

(5] This driver is digitally signed.

Tell me why driver signing is important

N
Ciee D[ Gancel |

Figure 8 - 4 - Select Device Driver
13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.
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Troubleshooting

15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth
Radios.
16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

>

Figure 8 - 5 - Device Manager - Bluetooth Radio

. |
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Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the ports & jacks which allow your computer to commu-
nicate with external devices, connect to the internet etc.
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Ports and Jacks

Item

Description

Card Reader

The card reader allows you to use the following digital storage cards:

MMC (MultiMedia Card) RS MMC (requires PC adapter)
SD (Secure Digital) Mini SD (requires PC adapter)
MS (Memory Stick) MS Duo (requires PC adapter)

MS (Memory Stick Pro)

Cable (CATV)
Antenna Jack

Use this jack to connect a CATV cable if you have included the optional Mini-PCI TV Tuner in
your purchase.

Consumer Infrared

The consumer infrared transceiver at the front of the computer allows the computer to

Transceiver communicate with the remote control unit supplied with the optional Mini-PCI TV Tuner.
DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.
DVI-Out Port The DVI-Out (Digital Visual Interface) Port is a video connector interface. This allows you to

connect an external monitor, TV or Flat Panel Display etc. as a display device (see “Configuring
an External Display using the NVIDIA Control Panel” on page B - 7) by means of a DVI cable.
If you are using an older type of monitor you will need to use a converter to convert the signal
from DVI to VGA.
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Item Description
e-SATA/USB Port This is a combined e-SATA (external Serial Advanced Technology Attachment)/ USB 2.0
e-SATA | o< compatible port.

Plug external Serial ATA hard drives into this e-SATA (external Serial Advanced Technology
Attachment) port. See “USB 2.0/1.1 Ports” on page A - 5 for USB port information.

HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) port is an audio/video connector

HDMI interface for transmitting uncompressed digital streams. This allows you to connect an external
monitor, TV or Flat Panel Display etc. as a display device (see “Configuring an External
Display using the NVIDIA Control Panel” on page B - 7) by means of a HDMI cable. Note that
HDMI carries both audio and video signals (see “HDMI Audio Configuration” on page 2 -

12).
HDMI-IN Port The HDMI-In (High-Definition Multimedia Interface) port allows you to display external sources
HDMI-IN such as Blu-ray players, DVDs, set top boxes and games consoles etc. on your computer screen

(see “GameMate Media Player (HDMI-In)” on page 2 - 9).

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume
to a reduced level before connecting to this jack.

Line-In Jack The Line-In jack allows you to play audio sources through the computer’s speakers. Note that
audio input through Line-in will default to the mute setting. To set up your audio sources to play
through the Line-in jack go to the Sound control panel and make sure the Mute box is not
ticked.
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Item

Description

Microphone-In Jack

Plug an external microphone in to this jack to record on your computer.

Mini-IEEE 1394 Port

This allows high-speed connection to various peripheral devices, e.g. external disk drives and
digital cameras (see note below).

4

IEEE 1394
The Mini-IEEE 1394 ports only support SELF POWERED IEEE 1394 devices.

RJ-45 LAN Jack

This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

S/PDIF-Out Jack

This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

Security Lock Slot

To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.
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Item Description

USB 2.0/1.1 Ports These USB (Universal Serial Bus) 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are
for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals
such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be
plugged into the computer, and unplugged from the computer, without the need to turn the
USB 3.0 Port system off (if the power rating of your USB device is 500mA or above, make sure you use the
power supply which comes with the device).

This model has two USB 3.0 ports on the left side of the computer which are denoted by their blue
color. USB 3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with
USB 2.0.

Note that the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7).
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NVIDIA Video Driver Controls

Appendix B: NVIDIA Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on
page 1-17.

NVIDIA Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

1.

N

Insert the Device Drivers & Utilities + User’s Manual disc and click Install
Drivers (button).

Click 1.Install Video Driver > Yes.

Click Next > Yes > Next.

Click Finish to restart the computer.

4

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and chang-
es. Check with your service center for the latest details on video cards supported. Note that
not all video card options for this computer model series support SLI configuration (see
“Video Adapter Options” on page D - 2, or contact your service center for details).

NVIDIA Video Driver Installation B - 1
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NVIDIA Control Panel (Win 7)

More advanced video configuration options are provided in the NVIDIA Control

4

NVIDIA Control
Panel

To access the Ge-
Force..... control panel
from the desktop; right-
click the desktop, then
click NVIDIA Control
Panel.

FigureB-1
NVIDIA GeForce.....
Control Panel

Panel tab.
1. Openthe Display Settings (see page 1 - 17) control panel.
2. Click Advanced Settings (button).
3. Click GeForce..... (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments.
OR
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the

menu if you are in Control Panel Home).

B - 2 NVIDIA Control Panel (Win 7)



The NVIDIA Control Panel provides additional video configuration controls and
tools which allow quick access to features such as display configuration, 3D Settings

and Help menus etc.

.|
NVIDIA Control Panel (Win7) B - 3

NVIDIA Video Driver Controls

4

Navigating the
Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.

Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

Figure B - 2
NVIDIA Control
Panels



NVIDIA Video Driver Controls

The Help menus provide index and search features, and direct links to the NVIDIA
website etc.

Figure B -3
Help Menu
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Display Devices

Note that you can use a DVI cable connected to the DVI-Out port, or an HDMI _ Z _
(High-Definition Multimedia Interface) cable connected to the HDMI-Out port to Display Devices
connect an external display (if you are using an older type of monitor you can use @ | gesides the built-in
converter to convert the signal from DVI to VGA). See your display device manual LCD, you can also use

to see which formats are supported. an external monitor/flat
panel display as your
display device. The dis-

1. The built-in LCD. play options are:

2. An external display connected to the DVI-Out Port.
3. An external display/TV (if the TV supports an HDMI connection) connected to the The built-in LCD.

HDMI-Out Port. An external display
connected to the DVI-

Monitor and TV Tuner

Out port.

An external display
connected to the
HDMI-Out port.

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aer-
ial to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tun-
er first, then the monitor.

Note that HDMI sup-
ports video and audio
signals.

DO NOT use the Fn +
F7 key combination to
toggle through display
options when SLI is en-
abled.
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- Display Modes

SE el e | Single Display M_Ode _
Multiple Displays Only one of your displays is used.

Note that if SLI configu- . .
ration is enabled only a Duplicate Displays

S e Duplicate simply shows an exact copy of the Primary display desktop on the other

FEERRCER R ENAE R display(s). This mode will drive multiple displays with the same content.
vice.

ol fepie i Sl Extend Desktop

o a e ol Extend Desktop treats both connected displays as separate devices, and they act as
CClIERICEEEIEREVSE 3 virtual desktop resulting in a large workspace. When enabled, you can drag any
SRR R R icons or windows across to the other display desktop. It is therefore possible to have

abled. SLI supports onl S - . .
aSingle dispf:;,, 1] at)f one program visible in one of the displays, and a different program visible in the oth-

tempting to configure [ECESIEEVA
dual displays may cause

an error. Use the NVID-

IA control panel to select

the display to be used.

Note that not all video
card options for this
computer model series
support SLI configura-
tion.

B - 6 Display Modes



NVIDIA Video Driver Controls

Configuring an External Display using the NVIDIA Control Panel
You can use the NVIDIA control panel to configure any attached displays.

1.
2.
3.

5.
6.

Display Modes B - 7

Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
Go to NVIDIA Control Panel (see page B - 2).

Double-click Display (if the sub-menus are not visible), and then click Set up
multiple displays.

Any attached display will appear under “1.Select the displays you want to use.”

-

— >

Click the tickbox alongside any display you wish to use.
Click Apply > Yes to save any changes made.

4

Display Not Shown

If the attached display
does not appear in the
“1.Select the displays
you want to use.” win-
dow, click “My Display
is not shown..” and
then click the appropri-
ate button to force de-
tection of the missing
display.

Figure B - 4
Set Up Multiple
Displays
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Duplicating the Displays

1.
2.
3.
4.
5.
6
Figure B-5
Duplicate
Displays
7.

Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
Go to NVIDIA Control Panel (see page B - 2).

Double-click Display (if the sub-menus are not visible), and then click Set up
multiple displays.

Any attached display will appear under “1.Select the displays you want to use.”
Click the tickbox alongside any display you wish to use.

Right-click one of the display icons and click “Duplicate displays....” (select which
is to be the primary display) to duplicate the desktop on both displays.

Select Apply > Yes to save changes

Right-click to select Duplicate displays
and which is to be used as the primary display.

Click Apply > Yes to save any changes.
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Extending the Display

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.

2. Goto NVIDIA Control Panel (see page B - 2).

3. Double-click Display (if the sub-menus are not visible), and then click Set up
multiple displays.

4. Click to select a primary display under “1.Select the displays you want to use.”

5. Right-click one of the display icons and click “Extend Desktop on this display....”
to extend the desktop across both displays.

Sl I Select Apply > Yes

to save changes Figure B - 6
Extend the Display

Click to select the display to be used as the primary display.
_——

Right-click Extend desktop on this display

6. Click Apply > Yes to save any changes.
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Changing the Primary Display on Extended Displays

1. If you want to switch the primary display if the displays are extended then right-
click the secondary display icon.

2. Select Make this the Windows primary display.

3. Click Apply > Yes to save the change.

FigureB-7
Switch Primary

Display Select Apply > Yes
to save changes

Right-click to select the secondary display
and select Make this the Windows primary display.

B - 10 Display Modes
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Attaching Other Displays (Win 7)

Configuring an External Display in Windows 7

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Gotothe Screen resolution control panel.

3. Click the Detect button. ::“C%am”b‘i’:zﬂt::t';qo* FIZ
4. The computer will then detect any attached displays. thr}éugh the! display ggp_
tions:

4

Function Key
Combination

« Notebook Only
« External Display Only

+ Notebook + External

Make sure you give the

displays enough time to
refresh.

DO NOT use the Fn + F7
key combination to toggle
through display options
when SLI is enabled.

Figure B -8
Screen Resolution
Multiple Displays
(Win 7)
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5.  You can configure the displays from the Multiple Displays menu.

Figure B - 9
Screen Resolution
Multiple Display
Options
(Win 7)

» Duplicate these displays - Shows an exact copy of the main display desktop on

the other display(s)
» Extend these displays - Treats both connected displays as separate devices

» Show desktop only on 1/2 - Only one of your displays is used.
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Using the Windows Logo Key & + P Key Combination to Switch Displays

You can also use the & + P key combination to quickly change display configura-
tion and modes (this is particularly useful when attaching a projector) in Windows 7.

Attach your external display to the external monitor port and turn it on.

Press the & + P key combination.

An on-screen menu will pop up.

Use the cursor keys (or s + P) to select the appropriate configuration from the
menu, and press Enter to confirm the selection.

PoNPE

Figure B - 10
s + P Display
Configuration
Selection
(Win 7)

.|
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4

Video Card
Options

Note that card types,
specifications and driv-
ers are subject to con-
tinual updates and
changes. Check with
your service center for
the latest details on
video cards supported.
Note that not all video
card options for this
computer model series
support SLI configura-
tion (see “Video
Adapter Options” on
page D - 2, or contact
your service center
for details).

Figure B - 11
Set SLI
Configuration

NVIDIA Video Driver Controls

SLI Multi GPU Configuration

This computer features an NVIDIA Scalable Link Interface (SLI) that improves
graphic quality and performance by combining dual NVIDIA GPUs (two video
cards are required) in a single system. To enable/disable SLI Configuration:

1. Goto NVIDIA Control Panel (see page B - 2).

2. Click “+" next to 3D Settings if its sub-items are not shown and then click Set SLI
and PhysX configuration.

Select Yes

> to restart the computer

>

3. Click “Enable SLI technology (recommended)” under “2.Select an SLI
configuration:”.
. Click to “Select the SLI focus display:” (only a single display may be used).
5. Click Apply and Yes to restart the computer (see over).
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SLI Multi GPU Configuration & Battery Power

Note that due to the high power and system demands created by enabling SLI1 Con-

SN
L&

figuration, you should not enable SLI configuration if your computer is powered B SISRSITe LR
Multiple Displays

by battery only. If you attempt to run an SLI configuration when the computer is

powered by the battery only, then system problems may occur. Note that if SLI configu-
ration is enabled only a

« If the computer is currently powered by battery only do not enable SLI config- [ SelEREEsEVRIEELE
used as the display de-

uration. vice.
« If you have currently enabled SLI configuration, and the computer is powered DO NOT use the Fn +
by the AC/DC adapter, do not switch to battery power only (or go to the LG Gl 1Y
. . R e toggle through display
NVIDIA Control Panel and disable SLI configuration before switching to bat- options when SLI is en-
tery power only). abled. SLI supports only

a Single display, and at-
tempting to configure
dual displays may cause
an error. Use the NVID-
IA control panel to select
the display to be used.

.|
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Enabling TV Display

Z To display desktop images on a TV, connect the TV to your computer by using an
Detect Displays HDMI cable/DVI cable from the TV to the HDMI-Out port/DVI-Out port (if sup-

To get a full range of dis- portEd by your TV)-

lay options click “My dis- . .
E,:{,?sp '::tssch'f,wn ,);, t'hse You will need to enable the TV display from the NVIDIA Control Panel as per the

list...”. instructions on B - 7. The TV will appear as a display option (1. Select the displays

HDMI Audio Setup you would like to use.) when attached to the appropriate port. Apply the settings,
and then click Yes to save the changes.

See “HDMI Audio Con-

figuration” on page 2 -

12 for instructions on

configuring audio for

HDMI display devices.

Set up your external dis-
play (TV or LCD) for
HDMI input (see your
display device manual).

B Figure B - 12

Set Up Multiple
Displays
(with TV connected)

.|
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Changing the TV Signal Format

1. Whenthe TV is enabled as a display device click the sub-menus under Video &
Television.

2. Click “Change the signal or HD format”.

3. Select the connector or format you want to use (the menu that appears will depend
upon your type of connector).

4. Apply the settings, and then click Yes to save the changes.

Figure B - 13

Change the Signal or
HD Format

Enabling TV Display B - 17
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The NVIDIA Control Panel provides additional configuration controls to adjust the
TV settings in the Video & Television menu.

Figure B - 14
NVIDIA Control
Panels
(Video &
Television)
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Appendix C: ATl Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on

page 1 - 21. 4
. . . Video Card

ATI Video Driver Installation Options
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. Note that card types,
Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers specifications and driv-
(button) ers are subject to con-

' tinual updates and
1. Click 1.Install Video Driver > Yes. changes. Check with

. our service center for
2. Click Next > Install (button). ¥he latest details on

3. Click the Express (or Custom if you prefer to manually configure the video cards supported.
driver installation settings) button and click Next.

4. Click Accept (button) and click Yes.

5. Click Finish > Yes to restart the computer.

Note: After installing the video driver go to the Display/Display Settings control
panel to adjust the video settings to the highest resolution.

ATI Video Driver Installation C - 1
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ATI Catalyst® Control Center

1. Openthe ATI Catalyst Control Center (see page 1 - 21).

2. Click Advanced (button).

3. A wizard will help you set up the display options, or you can click Advanced
(button) to go to the ATI Catalyst Control Center (you can change the options
from the Basic menu or the View menu in the ATI Catalyst Control Center).

4. Note that the Advanced options are featured in this chapter (if you choose Basic
the on-screen Wizard will help you configure your display options)

Click Advanced Button to go to
the ATI Catalyst Control Cen-
ter. You can change the options
rom Advanced to Basic by
clicking the appropriate button.

Note that the control panels pic-

: _ tured in the following pages are
Flgure C-1 © from the Advanced settings.
ATI Catalyst Control

Center Basic Settings

C - 2 ATI Catalyst® Control Center



ATI Video Driver Controls

More advanced video configuration options are provided in the ATI Catalyste
Control Center. 4

1. Open the Display Settings (see page 1 - 17) control panel. ATl Taskbar Icon
2. Click Advanced Settings (button).

3. Click Catalyst(TM) Control Center (tab).

4. Click ATI Catalyst(TM) Control Center (button).

The ATI Catalyst Control
Center can be accessed as
above or by double-clicking
the icon in the taskbar
(or by right-clicking the icon
:) and selecting Catalyst
Control Center).
If you don’t see the ATl icon
in the taskbar, click Op-
tions > Preferences (tab)
in the ATI Catalyst® Con-
trol Center, and select En-

able System Tray Menu
(see Figure 1 - 12 on page

1-22).
Right-click the ATl icon

( ) to bring up the taskbar
menu.

Figure C - 2

ATI Catalyst Control
Tab & Desktop

ATI Catalyst® Control Center C - 3



ATI Video Driver Controls

The ATI Catalyst® Control Center provides additional video configuration con-
4 | trols and tools which allow quick access to features such as display options, 3D Set-
tings, color and Help menus etc. Adjust settings from the Graphics and Options
menus at the top of the control panel.

Help

For help on any subject,
click Options in the top
tight of the control panel
and then click Help and
select a Help item from
the menu.

Figure C - 3

ATI Catalyst Control
Panels

.|
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Attaching Other Displays

Besides the built-in LCD, you can also use an external monitor/flat panel display as
your display device. The following are the display options:
Besides the built-in

* The built-in L_CD- LCD, you can also use
» An external display connected to the DVI-Out Port. an external monitor/flat

» An external display/TV connected to the HDMI-Out Port. panel display as your
display device. The dis-

play options are:
Monitor and TV Tuner

4

Display Devices

The built-in LCD.

An external display
connected to the DVI-
Out port.

An external display
connected to the
HDMI-Out port.

Note that HDMI sup-
ports video and audio
signals.

DO NOT use the Fn +
F7 key combination to
toggle through display
options  when  ATI
CrossFireX™ is en-
abled.

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aer-
ial to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tun-
er first, then the monitor.

ATI CrossFireX™ Configuration & Multiple Displays

Note that ATl CrossFireX™ uses two GPUs to deliver exceptional graphic performance on
a single display. DO NOT enable ATI CrossFireX™ ina multiple display configuration.
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Display Modes

ATI CrossFireX™
Configuration &
Multiple Displays Duplicate
Mo iNile =" Duplicate s_imply shoyvs an exact copy of the Maip display desktop on the other dis-
et 8 play(s). This mode will drive multiple displays with exactly the same content, reso-

SHELIEERERIVEC SR Jution, refresh rates and color quality etc. (do not use if CrossFireX™ is enabled).
display may be used as

the display device. Extend
S0l \ohr =l Extend treats both connected displays as separate devices, and they act as a virtual
=G0l ool desktop resulting in a large workspace. When a display is Extended, you can drag
el SRR IEEVAE  any icons or windows across to the other display desktop. It is therefore possible to
options. have one program visible in one of the displays, and a different program visible in
the other display (do not use if CrossFireX™ is enabled).

Single
Only one of your displays is used.

Use the ATI control pan-
el to select the single
3 \ A/
display mode to be 7£l§
used in a CrossFirex™

configuration. Switching Displays

Note: It is recommended that you use only the ATI Catalyst Control Center to switch and

configure attached displays.
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Configuring an External Display using the ATI CCC
Use the ATI Catalyst Control Center to configure any attached displays.

1
2.
3.
4

5.

Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
Open the ATI Catalyst Control Center.

Select Desktops & Displays from the Graphics menu in the top left of the screen.
Attached displays will appear in the lower part of the screen (click Detect Displays
to find any attached displays that do not automatically appear).

Click the triangle icon W (or right-click the display icon) on the attached display
icon to bring up the options (e.g Duplicate or Extend).

Select an option from the menu, and click Yes to accept the settings.

Click OK to save the changes.

Attached displays
will appear here.

Attaching Other Displays C - 7
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Detect Displays

Click Detect Displays
(button) to automati-
cally update the at-
tached display
information.

You can set a prefer-
ence for automatic dis-
play detection in
Display Options. You
can choose to have at-
tached displays auto-
matically detected
when the ATI CCC is
opened, or to use man-
ual detection only.

FigureC -4
Desktops &
Displays



ATI Video Driver Controls

HDMI Notes

» Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.

HDMI Video Configuration

1. Connect an HDMI cable from the HDMI-Out port to your external display.

2. Configure your external display as per the instructions provided on the following
pages.

3. Set up your external display (TV or LCD) for HDMI input (see your display device
manual).

4. You can now play video/audio sources through your external display.

HDMI Settings in Other Applications

If you are using a third party application to play DVDs etc. you will need to consult
the application’s documentation to see the appropriate audio configuration (the ap-
plication must support digital to analog translation).
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HDMI Audio Configuration

As HDMI (High-Definition Multimedia Interface) carries both audio and video sig-
nals you can configure the audio output as per the instructions below.

Audio Setup for HDMI with ATI Video Cards

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound  (Hardware and Sound).

Click Playback (tab), and click to select ATI HDMI Output.

Click Set Default (button).

Click OK to close the Sound  control panel.

Select Speakers as the default for standard audio sources.

Two HDMI sound play-
back devices will appear
in the control panel when

an HDMI enabled device FigureC-5
is attached. S
Sound Playback

Use only the highlighted Options
(Ready) device to config-

ure the audio.

Attaching Other Displays C - 9
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CrossFirex™

This computer features CrossFireX™ that improves graphic quality and perfor-
mance by combining dual ATI1 GPUs (two video cards are required) in a single sys-
tem. To enable/disable CrossFirexX™.

. . 1. Open the ATI Catalyst Control Center.
Nc;?Mthat 'f’?T' Crtpss':_" 2. Select CrossFireX™ from the Graphics menu in the top left of the screen.
= SRSl 3. Click Enable CrossFireX™.
4

enabled only a Single . .
display may be used as Click OK (or click Apply > Yes).

the display device.

ATI CrossFirex™

Configuration &
Multiple Displays

DO NOT use the Fn +
F7 key combination to
toggle through display
options.

Use the ATI control pan-
el to select the single
display mode to be
used in a CrossFireXx™
configuration.

FigureC-6
CrossFirex™

. |
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CrossFireX™ Multi GPU Configuration & Bat-
tery Power

Note that due to the high power and system demands created by enabling a Cross-
FireX™ configuration, you should not enable a CrossFireX™ configuration if
your computer is powered by battery only. If you attempt to run a CrossFireXm
configuration when the computer is powered by the battery only, then system prob-
lems may occur.

 If the computer is currently powered by battery only do not enable a CrossFi-
reX™ configuration.

 If you have currently enabled a CrossFireX™ configuration, and the computer
is powered by the AC/DC adapter, do not switch to battery power only (or go
to the ATI Control Panel and disable CrossFireX™ before switching to battery
power only).

.|
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PowerPlay ™

PowerPlay™ in the AT1 CCC allows you to set your graphics processor settings for
higher performance or longer battery life.

FigureC -7
PowerPlay™
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Appendix D: Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.

.|
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Specifications

Intel® Core i7-720QM Mobile Processor:
1.6GHz

45nm (45 Nanometer) Process
Technology, 6M L3 Cache &

FSB 1333MHz - TDP 45W

rPGA988A Package

Intel® Core i7-820QM Mobile Processor:
1.73GHz

45nm (45 Nanometer) Process
Technology, 8M L3 Cache &

FSB 1333MHz - TDP 45W

rPGA988A Package

Intel® Core i7-920XM Mobile Processor:
2.00GHz

45nm (45 Nanometer) Process
Technology, 8M L3 Cache & FSB
1333MHz - TDP 55W

rPGA988A Package

Intel® Core i7-940XM Mobile Processor:
2.13GHz

45nm (45 Nanometer) Process
Technology, 8M L3 Cache & FSB
1333MHz - TDP 55W

rPGA988A Package

Intel® PM55 Chipset

18.4" (46.74cm) HD+ (1680 * 945) / FHD
(1920 * 1080) 16:9 TFT LCD

DDRIII (DDR3) Dual Channels

Two 204 Pin SO-DIMM Sockets
Supporting DDRIII (DDR3) 1066MHz/
1333MHz Memory Modules

Memory Expandable up to 8GB
Compatible with 2GB or 4GB Modules

nVIDIA® GeForce GTX 285M PCle
Video Card

1GB GDDRS3 Video RAM On Board
Supports PCle * 8 (SLI - 2 * PCle * 8)
Supports Microsoft DirectX® 10.0
Supports HDCP

Supports SLI

nVIDIA® GeForce GTX 460M PCle
Video Card

1.5GB GDDR5 Video RAM on board
Supports PCle * 8 (SLI - 2 * PCle * 8)
Supports Microsoft DirectX® 11.0
Supports HDCP

Supports HDMI 1.4

Supports SLI

Supports DVI Dual Link

nVIDIA® GeForce GTX 480M PCle
Video Card

2GB GDDR5 Video RAM On Board
Supports PCle * 16

Supports Microsoft DirectX® 11.0
Supports HDCP

Supports HDMI 1.4

Supports DVI Dual Link

D - 2 Specifications



nVIDIA® Quadro FX 2800M PCle Video
Card

1GB GDDRS3 Video RAM On Board
Supports PCle * 8 (SLI - 2 * PCle * 8)
Supports Microsoft DirectX® 10.0
Supports HDCP

Supports DVI Dual-Link

Supports Open GL 3.1

nVIDIA® Quadro FX 3800M PCle Video
Card (Does not support SLI)

1GB GDDR3 Video RAM On Board
Supports PCle * 8 (SLI - 2 * PCle * 8)
Supports Microsoft DirectX® 10.1
Supports HDCP

Supports DVI Dual-Link

Supports Open GL 3.1

ATl Radeon HD5870 PCle Video Card
1GB GDDRS5 Video RAM on board
Supports CrossFireX™

Supports PCle * 8

Supports Microsoft DirectX® 11
Supports HDCP

Supports DVI Dual-link

One 32Mb Flash ROM
Phoenix™ BIOS

Up to three (Factory Option)
Changeable 2.5" 9.5 mm (h) SATA
(Serial) Hard Disk Drives supporting
RAID level 0/1/5

One 12.7 mm Super Multi/Blu-Ray
Combo/Blu-Ray Writer SATA Optical
Device Drive (Factory Option)

High Definition Audio

S/PDIF Digital Output

Built-In Microphone (Digital Array)

5.1 Channel Speakers (with Sub woofer)
Dolby Home Theater 5.1 Channel
Certified

Specifications

Full Size Winkey Keyboard with Numeric
Keypad

Built-In TouchPad (with Multi Gesture
Functionality)

Eight Touch Sensor Instant Keys (Color,
CCD, Bluetooth, WLAN, Internet, Silent
Mode, Sound Effect, Mute)

Eight Gaming Keys G1 ~ G8

Embedded 7-in-1 Card Reader (MS/ MS
Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS
Duo) Note: MS Duo/ Mini SD/ RS MMC
Cards require a PC adapter

Two Mini Card Slots:
Slot 1 for PCle WLAN Module
Slot 2 for PCle TV Tuner Module
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Specifications

Four USB 2.0 Ports

Two USB 3.0 Ports

One eSATA Port

One Mini-IEEE1394a Port

One DVI-Out Port (with CRT out)

One HDMI-Out (High-Definition
Multimedia Interface) Port (with HDCP
Support)

One HDMI-In (High-Definition Multimedia
Interface) Port (with HDCP Support)

One RJ-45 LAN Jack

One Headphone/Speaker-Out Jack

One Microphone-In Jack

One Line-In Jack

One S/PDIF Out Jack

One DC-In Jack

One Consumer Infrared Port for TV Tuner
Remote Controller

One CATV-In Jack (for TV Tuner)

Built-In 10/100/100 Base-TX Ethernet LAN

Bluetooth 2.1 + EDR (Enhanced Data
Rate) Module (Factory Option)

Combo WLAN (802.11b/g/n) and
Bluetooth v3.0 Module (Factory Option)

Intel® WiFi Link 5300 Series (3*3 -
802.11a/g/n) Wireless LAN PCle
Interface Half Mini-Card Module (Factory
Option)

3rd Party 802.11b/g/n Wireless LAN PCle
Interface Half Mini-Card Module (Factory
Option)

3.0M Pixel PC Video Camera Module
(Factory Option)

Mini-Card TV Tuner Module (Factory
Option)

Security (Kensington® Type) Lock Slot
BIOS Password

Fingerprint Reader Module (Factory
Option)

Windows® 7

Note that the TV Tuner module (factory)
option in is supported by the Windows
Media Center software. Windows Media
Center is not included in Starter or
Home Basic versions of Windows 7.

Supports Wake on LAN
Supports Wake on USB

Full Range AC/DC Adapter — AC in 100 -
240V, 50 - 60Hz DC Output 20V, 11A
(220 Watts)

Removable Polymer Smart Lithium-lon
68.82Wh Main Battery

D - 4 Specifications



Specifications

Temperature

Operating: 5°C-35°C
Non-Operating: -20°C - 60°C
Relative Humidity

Operating: 20% - 80%
Non-Operating: 10% - 90%

439mm (w) * 299mm (d) * 44-59.1mm (h)
Around 5.6kg with Battery and ODD
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